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Course Code Credits L-T-P Assessment Exam 

Duration SEE CIE 

Spread 

Sheet For 

Engineers 

BME358C 02 0-0-2 50 50 3 Hrs 

 
 

Course objectives: 
 To create different plots and charts 
 To compute different functions, conditional functions and make regression analysis. 
 To carryout iterative solutions for roots, multiple roots, optimization and non-linear regression analysis 
 To carryout matrix operations 
 To Understand VBA and UDF 
 To understand VBA subroutines and Macros 

 To carryout numerical integration and solving differential equations using different methods 
 

Sl NO Experiments 

1 Charting: Create an XY scatter graph, XY chart with two Y-Axes, add error bars to your plot, create a combination chart 

2 Functions: Computing Sum, Average, Count, Max and Min, Computing Weighted Average, Trigonometric Functions, 
Exponential Functions, Using The CONVERT Function to Convert Units 

 

3 
Conditional Functions: Logical Expressions, Boolean Functions, IF Function, Creating a Quadratic Equation Solver, Table 
VLOOKUP Function, AND, OR and XOR functions. 

 

4 
Regression Analysis: Trendline, Slope  and   Intercept,   Interpolation and Forecast, The LINEST Function, 

 
Multilinear Regression, Polynomial Fit Functions, Residuals Plot, Slope and Tangent, Analysis ToolPack. 

 

5 
Iterative Solutions Using Excel: Using Goal Seek in Excel, Using The Solver To Find Roots, Finding Multiple Roots, 
Optimization Using The Solver, Minimization Analysis, NonLinear Regression Analysis. 

 

6 
Matrix Operations Using Excel: Adding Two Matrices, Multiplying a Matrix by a Scalar, Multiplying Two Matrices, 
Transposing a Matrix, Inverting a Matrix and Solving System of Linear Equations. 

 

7 
VBA User-Defined Functions (UDF): The Visual Basic Editor (VBE), The IF Structure, The Select Case Structure, The For 
Next Structure, The Do Loop Structure, Declaring Variables and Data Types, An Array Function The Excel Object Model, For 
Each Next Structure. 

 

8 
VBA Subroutines or Macros: Recording a Macro, Coding a Macro Finding Roots by Bisection, Using Arrays, Adding a Control 
and Creating User Forms. 

 
Demonstration Exercises 

 

9 
Numerical Integration Using Excel: The Rectangle Rule, The Trapezoid Rule, The Simpson's Rule, Creating a User-Defined 
Function Using the Simpson's Rule. 

 

10 
Demonstration of reading, writing and organizing files. 

 

11 
Differential Equations: Euler's Method, Modified Euler's Method, The Runge Kutta Method, Solving a Second Order 

Differential Equation 
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Course outcomes (Course Skill Set): 

At the end of the course the student will be able to: 

 To create different plots and charts 

 To compute different functions, conditional functions and make regression analysis. 

 To carryout iterative solutions for roots, multiple roots, optimization and non-linear regression analysis 

 To carryout matrix operations 

 To Understand VBA and UDF 

 To understand VBA subroutines and Macros 

To carryout numerical integration and solving differential equations using different methods 

 
Reading: 

1. McFedries PaulMicrosoft Excel 2019 Formulas And Functions Microsoft Press, U.S, 2019 Edition 
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Institutes’ Vision 

To create centres of excellence in education and to serve the society by enhancing the quality of life 

through value based professional leadership. 

 

Institutes’ Mission 

 To provide high quality technical and professionally relevant education in a diverse learning 

environment. 

 To provide the values that prepare students to lead their lives with personal integrity, professional 

ethics and civic responsibility in a global society. 

 To prepare the next generation of skilled professionals to successfully compete in the diverse global 

market. 

 To promote a campus environment that welcomes and honors women and men of all races, creeds 

and cultures, values and intellectual curiosity, pursuit of knowledge and academic integrity and 

freedom. 

 To offer a wide variety of off-campus education and training programmes to individuals and 

groups. 

 To stimulate collaborative efforts with industry, universities, government and professional 

societies. 

 To facilitate public understanding of technical issues and achieve excellence in the operations of the 

institute. 

 

Department Vision 

 To create state of the art learning environment to nurture the learning. 

 Blending human values, academic professionalism and research process in the field of 

mechanical engineering. 

 Blending human values, academic professionalism and research process in the field of 

mechanical engineering for the betterment of society. 

Department Mission 

The mission of the department is to 

 Provide requisite foundation to our students in Mechanical Engineering. 

 Provide cutting edge laboratory resources to bridge the gap between theoretical and practical 

concepts. 

 Provide exposure to various mechanical industries through periodic industrial visits. 

 Enhance our students skill set and to make them industry ready by systematic skill 

development program. 
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List Of Experiments 
 
 

Sl 

No 
Experiment Name 

1 Charting: Create an XY scatter graph, XY chart with two Y-Axes, add error bars to your plot, create a 

combination chart 

2 Functions: Computing Sum, Average, Count, Max and Min, Computing Weighted Average, 

Trigonometric Functions, Exponential Functions, Using the CONVERT Function to Convert Units 

3 Conditional Functions: Logical Expressions, Boolean Functions, IF Function, Creating a 

Quadratic Equation Solver, Table VLOOKUP Function, AND, OR and XOR functions. 

4 Regression Analysis: Trendline, Slope and Intercept, Interpolation and Forecast, The LINESTFunctio 

 

Multilinear Regression, Polynomial Fit Functions, Residuals Plot, Slope and Tangent, Analysis 

Tool Pack. 

5 Iterative Solutions Using Excel: Using Goal Seek in Excel, Using the Solver to Find Roots, 

Finding Multiple Roots, Optimization Using the Solver, Minimization Analysis, Nonlinear 

Regression Analysis. 

6 Matrix Operations Using Excel: Adding Two Matrices, multiplying a Matrix by a Scalar, 

Multiplying Two Matrices, transposing a Matrix, inverting a Matrix and Solving System of Linear 

Equations. 

7 VBA User-Defined Functions (UDF): The Visual Basic Editor (VBE), The IF Structure, The Select 

Case Structure, The for Next Structure, The Do Loop Structure, Declaring Variables and Data Types, 

An Array Function the Excel Object Model, For Each Next Structure. 

8 VBA Subroutines or Macros: Recording a Macro, coding a Macro Finding Roots by Bisection, Using 

Arrays, adding a Control and Creating User Forms. 

 Only for Demo 

9 Numerical Integration Using Excel: The Rectangle Rule, The Trapezoid Rule, The Simpson's Rule, 

creating a User-Defined Function Using the Simpson's Rule. 

10 Differential Equations: Euler's Method, Modified Euler's Method, The Runge Kutta Method, Solving 

a Second Order Differential Equation 
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DEPARTMENT OF MECHANICAL ENGINEERING 
 

 LECTURE PLAN 
 

Faculty Name: Dr. Sushma S 
 

Sem. & Sec.: III ’A’ Sub: Spread sheet for engineers Sub. Code: BME358C 
 

Sl. 

No. 

 
Date 

Lesson 

Plan 

No. 

 
Name of the Experiment 

 
Remarks 

Batch 

1 
  

LP.1 

Create an XY scatter graph, XY chart with two Y- 

Axes, add error bars to your plot 

 

2 
 

LP.2 create a combination chart 
 

 

3 
  

LP.3 
Computing Sum, Average, Count, Max and Min, 

Computing Weighted Average 

 

 

 
4 

  
LP.4 

 

Trigonometric Functions, Exponential Functions, 

Using the CONVERT Function to Convert Units 

 

 
5 

  
LP.5 

 

Logical Expressions, Boolean Functions, IF 

Function, Creating a Quadratic Equation Solver 

 

 
6 

  
LP.6 

 AND, OR and XOR functions 
 

 

 
7 

  
LP.7 

Trendline, Slope and Intercept, Interpolation and 

Forecast  
 

 

 
8 

  
LP.8 

 Finding Multiple Roots, Nonlinear Regression 

Analysis. 
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9. 

  

 
LP.9 

Adding Two Matrices, multiplying a Matrix by a 

Scalar, Multiplying Two Matrices 

 

 

 

 

10. 

  

LP.10 

Transposing a Matrix, inverting a Matrix and Solving 

System of Linear Equations. 

 

 

11. 
  

LP.11 
Revision  

 
12. 

  
LP.12 

 

Lab IA 

 

 

 

 

EXTRA LABS 

Month DATE 

 
 

 

 
 

 

 
 

 
 

 

 

 
 

 

 

 

 

Signature of staff HOD
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Safety Precautions to the Students. 
 

1. Students are advised to come to the laboratory at least 5 minutes before (to the starting time), those 

who come after 5 minutes will not be allowed into the lab. 

2. Plan your task properly much before to the commencement, come prepared to the lab with the 

synopsis / program / experiment details. 

3. Student should enter the laboratory with: 

a. Laboratory observation notes with all the details (Problem statement, Aim, 

Algorithm, Procedure, Program, Expected Output, etc.,) filled in for the lab session. 

b. Laboratory Record updated up to the last session experiments and other utensils. 

(If any) needed in the lab. c. Proper Dress code and Identity card. 

4. Sign in the laboratory login register, write the TIME-IN, and occupy the computer system allotted 

to you by the faculty. 

5. Execute your task in the laboratory, and record the results / output in the lab observation notebook 

and get certified by the concerned faculty. 

6. All the students should be polite and cooperative with the laboratory staff, must maintain discipline 

and decency in the laboratory. 

7. Computer labs are established with sophisticated and high-end branded systems, which should be 

utilized properly. 

8. Students should LOG OFF/ SHUT DOWN the computer system before he/she leaves the lab after 

completing the task (experiment) in all aspects. He/she must ensure the system / seat is kept properly. 

. 
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Course Objectives & Outcomes. 
 

 

Course objectives: 
 To create different plots and charts
 To compute different functions, conditional functions and make regression analysis.
 To carryout iterative solutions for roots, multiple roots, optimization and non-linear regression 

analysis
 To carryout matrix operations
 To Understand VBA and UDF
 To understand VBA subroutines and Macros
 To carryout numerical integration and solving differential equations using different methods

 

Course Outcomes: 

At the end of the course students are able to 

 To create different plots and charts

 To compute different functions, conditional functions and make regression analysis.

 To carryout iterative solutions for roots, multiple roots, optimization and non-linear regression analysis

 To carryout matrix operations

 To Understand VBA and UDF

 To understand VBA subroutines and Macros

 To carryout numerical integration and solving differential equations using different methods
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CONTENTS 

Sl. No Particulars 
Page 

No 

1 Charting 01 

2 Functions 05 

3 Conditional Functions 24 

4 Regression Analysis 45 

5 Iterative Solutions Using Excel 86 

6 Matrix Operations Using Excel 139 

7 VBA User-Defined Functions (UDF): 146 

8 VBA Subroutines or Macros 157 
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EXPERIMENT-1 Date: 

 

 

Aim: Charting: Create an XY scatter graph, XY chart with two Y-Axes, add error bars to your plot, create 

a combination chart 
 

Use a scatter plot (XY chart) to show scientific XY data. Scatter plots are often used to find out if there's 

a relationship between variable X and Y. 

To find out if there is a relationship between X (a person's salary) and Y (his/her car price), execute the 

following steps. 
 

1 . Select the range A1 :B1 0 . 

 
 

2 . On the Insert tab, in the Charts group, click the Scatter symbol. 

 
 

3 . Click Scatter. 
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Result: 
 

 

Note: we added a trendline to clearly see the relationship between these two variables. 

 

2. On the Insert tab, in the Charts group, click the Scatter symbol. 

Two Y Axis and Combination Chart 

1. Select the data range and insert a chart first by clicking Insert and selecting a chart you need in 

the Chart group. 

 
2. Right click a column in the chart and select Format Data Series in the context menu. 
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3. Then in Format Data Series dialog, check Secondary Axis in the Plot Series On section, and click 

the Close button. 

 

4. Then right click the red column in the chart, select Change Series Chart Type. 

 

5. In Change Chart Type dialog, click Line in left pane, and select the line chart type you like. 

 
6. Click OK to close dialog, and you see the chart is inserted with two y axes. 
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Error Bars 

1. On 2-D area, bar, column, line, xy (scatter), or bubble chart, do one of the following: 

 To add error bars to all data series in the chart, click the chart area. 

 To add error bars to a selected data point or data series, click the data point or data 

series that you want, or do the following to select it from a list of chart elements: 

i. Click anywhere in the chart. 

This displays the Chart Tools, adding the Design, Layout, 

and Format tabs. 

ii. On the Format tab, in the Current Selection group, click the arrow next to 

the Chart Elements box, and then click the chart element that you want. 
 

2. On the Layout tab, in the Analysis group, click Error Bars. 
 

3. Do one of the following: 

a. Click a predefined error bar option, such as Error Bars with Standard Error, Error 

Bars with Percentage, or Error Bars with Standard Deviation. 

b. Click More Error Bar Options, and then under Vertical Error Bars or Horizontal 

Error Bars, click the display and error amount options that you want to use.
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EXPERIMENT-2 Date: 

 

 

Aim: Functions: Computing Sum, Average, Count, Max and Min, Computing Weighted Average, 

Trigonometric Functions, Exponential Functions, Using the CONVERT Function to Convert Units. 

 

SUM function 

The SUM function adds values. You can add individual values, cell references or ranges or a mix of all 

three. For example: =SUM (A2:A10) Adds the values in cells A2:10. =SUM (A2:A10, C2:C10) Adds the 

values in cells A2:10, as well as cells C2:C10 

 

AVERAGE function in Microsoft Excel. 

=AVERAGE (A1:A20) 

 

COUNT function: 

The COUNT function counts the number of cells that contain numbers and counts numbers within the list of 

arguments. Use the COUNT function to get the number of entries in a number field that is in a range or array 

of numbers. For example, you can enter the following formula to count the numbers in the range A1:A20: 

=COUNT (A1:A20). In this example, if five of the cells in the range contain numbers, the result is 5. 

 

Min, Max Functions: 

Min (expr) 

Max (expr) 

 

Find a Weighted Average: 

Use the SUMPRODUCT and the SUM functions to find a Weighted Average, which depends on the weight 

applied to the values. 

For example, a shipment of 10 cases of pencils is 20 cents per case. But a second shipment of 40 cases costs 

30 cents per case, because pencils are in high demand. If you averaged the cost of each shipment this way 

(0.20+0.30)/2 = 0.25, the result isn’t accurate. 

The math doesn’t take into account that there are more cases being sold at 30 cents than at 20 cents. To get 

the correct average, use this formula to get the result (28 cents per shipment): 

=SUMPRODUCT(A2:A3,B2:B3)/SUM(B2:B3) 

The formula works by dividing the total cost of the two orders by the total number of cases ordered. 
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Example:When the Weights Add Up to 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

100% 
 

When Weights Don’t Add Up to 100% 

 
Wrong: 

 

Correct: 
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When the Weights Need to be Calculated 
 

 
 

 

Calculating Weighted Average in Excel – SUM Function 
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SIN(number) 

 

The SIN function syntax has the following arguments: 

 

 Number Required. The angle in radians for which you want the sine. 

 

 

Remark 

 
If your argument is in degrees, multiply it by PI ()/180 or use the RADIANS function to convert it to radians. 

Example 

Copy the example data in the following table and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 

 

Formula Description Result 

=SIN(PI()) Sine of pi radians (0, approximately). 0.0 

=SIN(PI()/2) Sine of pi/2 radians. 1.0 

=SIN(30*PI()/180) Sine of 30 degrees. 0.5 

=SIN(RADIANS(30)) Sine of 30 degrees. 0.5 

 

 

 

COS Function: 

 

 

Description 

 
Returns the cosine of the given angle. 
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Syntax 

COS(number) 

The COS function syntax has the following arguments: 
 

 Number Required. The angle in radians for which you want the cosine. 

 

 

Remark 

 
If the angle is in degrees, either multiply the angle by PI()/180 or use the RADIANS function to convert the 

angle to radians. 

 

 

Example 

 
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 

 

Formula Description Result 

=COS(1.047) Cosine of 1.047 radians 0.5001711 

=COS(60*PI()/180) Cosine of 60 degrees 0.5 

=COS(RADIANS(60)) Cosine of 60 degrees 0.5 

 

 
TAN function 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac Excel for the web More... 
 

This article describes the formula syntax and usage of the TAN function in Microsoft Excel. 

Description 

Returns the tangent of the given angle. 

Syntax 

TAN(number) 

 

The TAN function syntax has the following arguments: 

 

 Number Required. The angle in radians for which you want the tangent. 
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Remark 

 

If your argument is in degrees, multiply it by PI()/180 or use the RADIANS function to convert it to radians. 

Example 

 

Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 

 

Formula Description (Result) Result 

=TAN(0.785) Tangent of 0.785 radians (0.99920) 0.99920 

=TAN(45*PI()/180) Tangent of 45 degrees (1) 1 

=TAN(RADIANS(45)) Tangent of 45 degrees (1) 1 

 

 
EXP function 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac Excel for the web Excel 2021 Excel 2021 for 

Mac Excel 2019 Excel 2019 for Mac Excel 2016 More... 
 

This article describes the formula syntax and usage of the EXP function in Microsoft Excel. 

Description 

Returns e raised to the power of number. The constant e equals 2.71828182845904, the base of the natural 

logarithm. 

 

 

Syntax 

 
EXP(number) 

 

The EXP function syntax has the following arguments: 

 

 Number Required. The exponent applied to the base e. 

 

 

Remarks 

 
 To calculate powers of other bases, use the exponentiation operator (^). 

 EXP is the inverse of LN, the natural logarithm of number. 
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Example 

 
Copy the example data in the following table and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 

 

Formula Description Result 

=EXP(1) Approximate value of e 2.71828183 

=EXP(2) Base of the natural logarithm e raised to the power of 2 7.3890561 

 

 
CONVERT function 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac Excel for the web More... 
 
 

Converts a number from one measurement system to another. For example, CONVERT can translate a table 

of distances in miles to a table of distances in kilometers. 

 

Syntax 

CONVERT(number,from_unit,to_unit) 

Number is the value in from_units to convert. 

From_unit  is the units for number. 

To_unit is the units for the result. CONVERT accepts the following text values (in quotation marks) for 

from_unit and to_unit. 
 

Measurement systems 
 

Weight and Mass 
 

"lbm" Pound mass (avoirdupois) 

"sg" Slug 

"g" Gram 

From_unit or to_unit Weight and mass 
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Weight and mass From_unit or to_unit 
 

 

U (atomic mass unit) "u" 

 
 

Ounce mass (avoirdupois) "ozm" 

 

 

Grain "grain" 

 

 

U.S. (short) hundredweight "cwt" or "shweight" 

 
 

Imperial hundredweight "uk_cwt" or "lcwt" ("hweight") 

 

 

Stone "stone" 

 

 

Ton "ton" 

 

 

Imperial ton "uk_ton" or "LTON" ("brton") 

 

Distance 
 

 

Distance 

 

From_unit or to_unit 

 

Meter 
 

"m" 

 

Statute mile 
 

"mi" 

 

Nautical mile 
 

"Nmi" 

 

Inch 
 

"in" 

 

Foot 
 

"ft" 
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Distance From_unit or to_unit 
 

 

Yard "yd" 

 
 

Angstrom "ang" 

 

 

Ell "ell" 

 

 

Light-year "ly" 

 
 

Parsec "parsec" or "pc" 

 

 

Pica (1/72 inch) "Picapt" or "Pica" 

 

 

Pica (1/6 inch) "pica" 

 

 

U.S survey mile (statute mile) "survey_mi" 

 

Time 
 

 

Time 

 

From_unit or to_unit 

 

Year 
 

"yr" 

 

Day 
 

"day" or "d" 

 

Hour 
 

"hr" 

 

Minute 
 

"mn" or "min" 

 

Second 
 

"sec" or "s" 

Pressure 
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Pressure From_unit or to_unit 
 

 

Pascal "Pa" (or "p") 

 
 

Atmosphere "atm" (or "at") 

 

 

mm of Mercury "mmHg" 

 

 

PSI "psi" 

 
 

Torr "Torr" 

 

Force 
 

 

Force 

 

From_unit or to_unit 

 

Newton 
 

"N" 

 

Dyne 
 

"dyn" (or "dy") 

 

Pound force 
 

"lbf" 

 

Pond 
 

"pond" 

Energy 
 

"e" Erg 

"J" Joule 

From_unit or to_unit Energy 
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Energy From_unit or to_unit 
 

 

Thermodynamic calorie "c" 

 
 

IT calorie "cal" 

 

 

Electron volt "eV" (or "ev") 

 

 

Horsepower-hour "HPh" (or "hh") 

 
 

Watt-hour "Wh" (or "wh") 

 

 

Foot-pound "flb" 

 

 

BTU "BTU" (or "btu") 

 

Power 
 

 

Magnetism 
 

"W" (or "w") Watt 

"PS" Pferdestärke 

"HP" (or "h") Horsepower 

From_unit or to_unit Power 

"T" Tesla 

From_unit or to_unit Magnetism 



Spread Sheet for Engineers  

16 | P a g e 

 

 

 

Magnetism From_unit or to_unit 
 

 

Gauss "ga" 

 

Temperature 
 

 

Temperature 

 

From_unit or to_unit 

 

Degree Celsius 
 

"C" (or "cel") 

 

Degree Fahrenheit 
 

"F" (or "fah") 

 

Kelvin 
 

"K" (or "kel") 

 

Degrees Rankine 
 

"Rank" 

 

Degrees Réaumur 
 

"Reau" 

Volume 
 

 

Volume (or liquid measure) 

 

From_unit or to_unit 

 

Teaspoon 
 

"tsp" 

 

Modern teaspoon 
 

"tspm" 

 

Tablespoon 
 

"tbs" 

 

Fluid ounce 
 

"oz" 

 

Cup 
 

"cup" 
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Volume (or liquid measure) From_unit or to_unit 
 

 

U.S. pint "pt" (or "us_pt") 

 
 

U.K. pint "uk_pt" 

 

 

Quart "qt" 

 

 

Imperial quart (U.K.) "uk_qt" 

 
 

Gallon "gal" 

 

 

Imperial gallon (U.K.) "uk_gal" 

 

 

Liter "l" or "L" ("lt") 

 

 

Cubic angstrom "ang3" or "ang^3" 

 

 

U.S. oil barrel "barrel" 

 

 

U.S. bushel "bushel" 

 

 

Cubic feet "ft3" or "ft^3" 

 

 

Cubic inch "in3" or "in^3" 

 

 

Cubic light-year "ly3" or "ly^3" 

 

 

Cubic meter "m3" or "m^3" 

 

 

Cubic Mile "mi3" or "mi^3" 
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Volume (or liquid measure) From_unit or to_unit 
 

 

Cubic yard "yd3" or "yd^3" 

 
 

Cubic nautical mile "Nmi3" or "Nmi^3" 

 

 

Cubic Pica "Picapt3", "Picapt^3", "Pica3" or "Pica^3" 

Gross Registered Ton "GRT" ("regton") 

Measurement ton (freight ton) "MTON" 

 

Area 
 

 

Area 

 

From_unit or to_unit 

 

International acre 
 

"uk_acre" 

 

U.S. survey/statute acre 
 

"us_acre" 

 

Square angstrom 
 

"ang2" or “ang^2" 

 

Are 
 

"ar" 

 

Square feet 
 

"ft2" or "ft^2" 

 

Hectare 
 

"ha" 

 

Square inches 
 

"in2" or "in^2" 

 

Square light-year 
 

"ly2" or "ly^2" 
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Area From_unit or to_unit 
 

 

Square meters "m2" or "m^2" 

 
 

Morgen "Morgen" 

 

 

Square miles "mi2" or "mi^2" 

Square nautical miles "Nmi2" or "Nmi^2" 

Square Pica "Picapt2", "Pica2", "Pica^2" or "Picapt^2" 

 

 

Square yards "yd2" or "yd^2" 

 

Information 
 

 

Speed 
 

"byte" Byte 

"bit" Bit 

From_unit or to_unit Information 

"m/h" or "m/hr" Meters per hour 

"kn" Knot 

"admkn" Admiralty knot 

From_unit or to_unit Speed 
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Speed From_unit or to_unit 
 

 

Meters per second "m/s" or "m/sec" 

 
 

Miles per hour "mph" 

 

The following abbreviated unit prefixes can be prepended to any metric from_unit or to_unit. 
 

 

Prefix 

 

Multiplier 

 

Abbreviation 

 

yotta 
 

1E+24 
 

"Y" 

 

zetta 
 

1E+21 
 

"Z" 

 

exa 
 

1E+18 
 

"E" 

 

peta 
 

1E+15 
 

"P" 

 

tera 
 

1E+12 
 

"T" 

 

giga 
 

1E+09 
 

"G" 

 

mega 
 

1E+06 
 

"M" 

 

kilo 
 

1E+03 
 

"k" 

 

hecto 
 

1E+02 
 

"h" 

 

dekao 
 

1E+01 
 

"da" or "e" 

 

deci 
 

1E-01 
 

"d" 
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Prefix 

 

Multiplier 

 

Abbreviation 
 

 

centi 
 

1E-02 
 

"c" 

 

milli 
 

1E-03 
 

"m" 

 

micro 
 

1E-06 
 

"u" 

 

nano 
 

1E-09 
 

"n" 

 

pico 

 

1E-12 

 

"p" 

 

femto 
 

1E-15 
 

"f" 

 

atto 
 

1E-18 
 

"a" 

 

zepto 
 

1E-21 
 

"z" 

 

yocto 
 

1E-24 
 

"y" 

 

Binary 

 

Prefix Value 

 

Abbreviation Derived 

Prefix  from 

 

yobi 
 

2^80 = 1 208 925 819 614 629 

 

"Yi" yotta 

 174 706 176  

 

zebi 

 

2^70 = 1 180 591 620 717 411 

 

"Zi" zetta 

 303 424  

 

exbi 
 

2^60 = 1 152 921 504 606 846 

 

"Ei" exa 

 976  

 

pebi 
 

2^50 = 1 125 899 906 842 624 
 

"Pi" peta 
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Binary 

 

Prefix Value 

 

Abbreviation Derived 

 

Prefix  from 

 

tebi 
 

2^40 = 1 099 511 627 776 
 

"Ti" tera 

 

gibi 
 

2^30 = 1 073 741 824 
 

"Gi" giga 

 

mebi 
 

2^20 = 1 048 576 
 

"Mi" mega 

 

kibi 
 

2^10 = 1024 
 

"ki" kilo 

Remarks 
 

 If the input data types are incorrect, CONVERT returns the #VALUE! error value. 

 If the unit does not exist, CONVERT returns the #N/A error value. 

 If the unit does not support a binary prefix, CONVERT returns the #N/A error value. 

 If the units are in different groups, CONVERT returns the #N/A error value. 

 Unit names and prefixes are case-sensitive. 
 

Examples 
 

This is an example of how a formula uses CONVERT. 
 

 

Formula 

 

Description 

 

Result 

 

=CONVERT(1, "lbm", "kg") 
 

Converts 1 

 

0.4535924 
 pound  

 mass to  

 kilograms.  

 

=CONVERT(68, "F", "C") 

 

Converts 
 

20 
 68 degrees  

 Fahrenheit  

 to Celsius.  

 

=CONVERT(2.5, "ft", "sec") 
 

Data types 

 

#N/A 

 are not  the  
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Formula Description Result 
 

same, so an 

error is 

returned. 

=CONVERT(CONVERT(100,"ft","m"),"ft","m") Converts 9.290304 

100 square 

feet into 

square 

meters. 

 

You can see how CONVERT works in Excel. Copy the following table (starting with the "6") and paste it to 

a blank Excel worksheet, placing the "6" in cell A1. 
 

 

6 
 

 

=CONVERT(A1,"C","F") Convert 6 degrees Celsius to 

 Fahrenheit (42.8)  

 

=CONVERT(A1,"tsp","tbs") 
 

Convert 6 teaspoons to 

(2) 

 

tablespoons 

 

=CONVERT(A1,"gal","l") 
 

Convert 6 gallons 

(22.71741274) 

 

to liters 

 

=CONVERT(A1,"mi","km") 
 

Convert 6 miles to 

(9.656064) 

 

kilometers 

 

=CONVERT(A1,"km","mi") 
 

Convert 6 kilometers 

(3.728227153) 

 

to miles 

 

 

Formula Description (Result) 

 

=CONVERT(A1,"in","ft") Convert 6 inches to feet (0.5) 
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=CONVERT(A1,"cm","in") Convert 6 centimeters to inches 

(2.362204724) 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

EXPERIMENT-3 Date: 

 

 

Aim: Conditional Functions: Logical Expressions, Boolean Functions, IF Function, Creating a 

Quadratic Equation Solver, Table VLOOKUP Function, AND, OR and XOR functions. 

 

 

Using IF with AND, OR and NOT functions 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac More... 
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The IF function allows you to make a logical comparison between a value and what you expect by testing for 

a condition and returning a result if that condition is True or False. 

 

 =IF(Something is True, then do something, otherwise do something else) 

 

But what if you need to test multiple conditions, where let’s say all conditions need to be True or False 

(AND), or only one condition needs to be True or False (OR), or if you want to check if a condition 

does NOT meet your criteria? All 3 functions can be used on their own, but it’s much more common to see 

them paired with IF functions. 
 

 

Here are overviews of how to structure AND, OR and NOT functions individually. When you combine each 

one of them with an IF statement, they read like this: 

 

 AND – =IF(AND(Something is True, Something else is True), Value if True, Value if False) 

 OR – =IF(OR(Something is True, Something else is True), Value if True, Value if False) 

 NOT – =IF(NOT(Something is True), Value if True, Value if False) 

 

 
Examples 

 
Following are examples of some common nested IF(AND()), IF(OR()) and IF(NOT()) statements. The AND 

and OR functions can support up to 255 individual conditions, but it’s not good practice to use more than a 

few because complex, nested formulas can get very difficult to build, test and maintain. The NOT function 

only takes one condition. 
 

 

Here are the formulas spelled out according to their logic: 
 

Technical Details 

=IF(AND(A2>0,B2<100),TRUE, FALSE) IF A2 (25) is greater than 0, AND 

B2 (75) is less than 100, then return 

TRUE, otherwise return FALSE. In 

this case both conditions are true, 

so TRUE is returned. 

=IF(AND(A3="Red",B3="Green"),TRUE,FALSE) If A3 (“Blue”) = “Red”, AND B3 

(“Green”)   equals   “Green”   then 

Description Formula 

https://support.microsoft.com/en-us/office/and-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.microsoft.com/en-us/office/and-function-5f19b2e8-e1df-4408-897a-ce285a19e9d9
https://support.microsoft.com/en-us/office/not-function-9cfc6011-a054-40c7-a140-cd4ba2d87d77
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Formula Description 

return TRUE, otherwise return 

FALSE. In this case only the first 

condition is true, so FALSE is 

returned. 

=IF(OR(A4>0,B4<50),TRUE, FALSE) IF A4 (25) is greater than 0, OR B4 

(75) is less than 50, then return 

TRUE, otherwise return FALSE. In 

this case, only the first condition is 

TRUE, but since OR only requires 

one argument to be true the formula 

returns TRUE. 

=IF(OR(A5="Red",B5="Green"),TRUE,FALSE)       IF A5 (“Blue”) equals “Red”, OR 

B5 (“Green”) equals “Green” then 

return TRUE, otherwise return 

FALSE. In this case, the second 

argument is True, so the formula 

returns TRUE. 

=IF(NOT(A6>50),TRUE,FALSE) IF A6 (25) is NOT greater than 50, 

then return TRUE, otherwise return 

FALSE. In this case 25 is not 

greater than 50, so the formula 

returns TRUE. 

=IF(NOT(A7="Red"),TRUE,FALSE) IF A7 (“Blue”) is NOT equal to 

“Red”, then return TRUE, 

otherwise return FALSE. 

 

Note that all of the examples have a closing parenthesis after their respective conditions are entered. The 

remaining True/False arguments are then left as part of the outer IF statement. You can also substitute Text 

or Numeric values for the TRUE/FALSE values to be returned in the examples. 

 

Here are some examples of using AND, OR and NOT to evaluate dates. 
 

 

Here are the formulas spelled out according to their logic: 
 

Formula Description 
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Formula Description 

=IF(A2>B2,TRUE,FALSE) IF A2 is greater than B2, return TRUE, 

otherwise return FALSE. 03/12/14 is 

greater than 01/01/14, so the formula 

returns TRUE. 

=IF(AND(A3>B2,A3<C2),TRUE,FALSE)       IF A3 is greater than B2 AND A3 is less 

than C2, return TRUE, otherwise return 

FALSE. In this case both arguments are 

true, so the formula returns TRUE. 

=IF(OR(A4>B2,A4<B2+60),TRUE,FALSE)   IF A4 is greater than B2 OR A4 is less 

than B2 + 60, return TRUE, otherwise 

return FALSE. In this case the first 

argument is true, but the second is false. 

Since OR only needs one of the 

arguments to be true, the formula returns 

TRUE. If you use the Evaluate Formula 

Wizard from the Formula tab you'll see 

how Excel evaluates the formula. 

=IF(NOT(A5>B2),TRUE,FALSE) IF A5 is not greater than B2, then return 

TRUE, otherwise return FALSE. In this 

case, A5 is greater than B2, so the 

formula returns FALSE. 
 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

IF function 

 

The IF function is one of the most popular functions in Excel, and it allows you to make logical comparisons 

between a value and what you expect. 

 

So an IF statement can have two results. The first result is if your comparison is True, the second if your 

comparison is False. 
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For example, =IF(C2=”Yes”,1,2) says IF(C2 = Yes, then return a 1, otherwise return a 2). 
 

 

 
 

Simple IF examples 

 

 

 =IF(C2=”Yes”,1,2) 

 

In the above example, cell D2 says: IF(C2 = Yes, then return a 1, otherwise return a 2) 
 

 

 =IF(C2=1,”Yes”,”No”) 

 

In this example, the formula in cell D2 says: IF(C2 = 1, then return Yes, otherwise return No)As you see, the 

IF function can be used to evaluate both text and values. It can also be used to evaluate errors. You are not 

limited to only checking if one thing is equal to another and returning a single result, you can also use 

mathematical operators and perform additional calculations depending on your criteria. You can also nest 

multiple IF functions together in order to perform multiple comparisons. 
 

 

 =IF(C2>B2,”Over Budget”,”Within Budget”) 

Syntax 

https://support.microsoft.com/en-us/office/how-to-avoid-broken-formulas-8309381d-33e8-42f6-b889-84ef6df1d586
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In the above example, the IF function in D2 is saying IF(C2 Is Greater Than B2, then return “Over Budget”, 

otherwise return “Within Budget”) 
 

 

 =IF(C2>B2,C2-B2,0) 

 

In the above illustration, instead of returning a text result, we are going to return a mathematical calculation. 

So the formula in E2 is saying IF(Actual is Greater than Budgeted, then Subtract the Budgeted amount from 

the Actual amount, otherwise return nothing). 
 

 

 =IF(E7=”Yes”,F5*0.0825,0) 

 

In this example, the formula in F7 is saying IF(E7 = “Yes”, then calculate the Total Amount in F5 * 8.25%, 

otherwise no Sales Tax is due so return 0) 

 

Solver: 

A solver is a mathematical tool present in MS-Excel that is used to perform calculations by working under 

some constraints/conditions and then calculates the solution for the problem. It works on the objective cell 

by changing the variable cells any by using sum constraints. 

Solver is present in MS- Excel but for using it we need to activate it. For activating the solver tool we need 

to do the following steps: 
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Step 1: Go to File and select options. The following dialog box will appear. 

 

Step 2: Now select the Add-ins option and click on Go and finally click on OK. 
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2 

 

 
 

Step 3: After clicking OK, Select Solver Add-in and press OK. Now solver will be activated in Excel. 

 

Step 4: Now solver will appear in data section like this. 
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Now let’s understand how to use solver with the help of an example. 

Example: 

We went to a mall and we also have a gift voucher worth rs.10,000 and We want to purchase items in such 

a manner that all the money of the gift voucher gets utilized. 

So, suppose we purchased the following items. 
 

Suppose we purchased the above items in only one quantity and the total came out to be 9300 but the 

voucher was for rs.10,000. So now we want to use Solver for this purpose. Now let’s see how it will be 

done. 

Step 1: Firstly go on data and find solver there and click it. The following dialog box will appear. Now in 

this, we have to select the objective in which we want to change our value. 
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Step 2: In the set objective we have to select the total of the D column because want the value to change 

from 9300 to 10,000. After clicking on D7 following thing will be displayed on the set objective block. 

 

Step 3: Now in the ‘By changing Variable cell’ we will select the Quantity cell because we want to change 

the quantity in such a way so that the total amount comes to 10,000. 
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Step 4: Now we have to set some conditions under which we want our work to get done. So for setting 

some conditions /constraints, we will click on Add. 



Spread Sheet for Engineers  

35 | P a g e 

2 

 

 

Step 5– Now, a dialog box will appear and we will add 3 conditions. The first condition is that the total 

amount should be equal to the voucher amount. So we will select cell D7 in a cell reference and then = 

sign, and finally, we will select cell C11. Now the first condition is added. To add the next condition press 

Add. 

 

Step 6: For the second condition we will select the Quantity cell because we want the quantity to be an 

integer value, a whole value. So in cell reference, we will select from B2 to B6 then int, and then again 

will press Add. 
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Step 7- Now for the third condition, we want that our item quantity should never be un negative which is 

not possible in real life. So we will select cells from B2 to B6 and should be >= to zero. Then click Add 

and cancel. 

 

Step 8: Now the following dialog box will show all the 3 conditions that we used and now click on Solve. 
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Step 9: By clicking Solve the solver will provide the desired output and to keep the answer we will click 

on keep solver solution. 
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So, this is what a solver is, How it is activated by not by default present in Excel and this is how it is used. 

 

 

How to get started 

 
There are four pieces of information that you will need in order to build the VLOOKUP syntax: 

 

1. The value you want to look up, also called the lookup value. 

2. The range where the lookup value is located. Remember that the lookup value should always be 

in the first column in the range for VLOOKUP to work correctly. For example, if your lookup 

value is in cell C2 then your range should start with C. 

3. The column number in the range that contains the return value. For example, if you specify 

B2:D11 as the range, you should count B as the first column, C as the second, and so on. 

4. Optionally, you can specify TRUE if you want an approximate match or FALSE if you want an 

exact match of the return value. If you don't specify anything, the default value will always be 

TRUE or approximate match. 

 

Now put all of the above together as follows: 

 

=VLOOKUP(lookup value, range containing the lookup value, the column number in the range containing 

the return value, Approximate match (TRUE) or Exact match (FALSE)). 

 

 

Examples 

 
Here are a few examples of VLOOKUP: 
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Example 1 
 

 

 
Example 2 

 

 

 
Example 3 
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Example 4 
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Example 5 
 

 

 
 

XOR function 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac More... 
 

The XOR function returns a logical Exclusive Or of all arguments. 

 

 

Syntax 

 
XOR(logical1, [logical2],…) 

 

The XOR function syntax has the following arguments. 
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 Logical1, logical2,… Logical 1 is required, subsequent logical values are optional. 1 to 254 

conditions you want to test that can be either TRUE or FALSE, and can be logical values, 

arrays, or references. 

 

 

Remarks 

 
 The arguments must evaluate to logical values such as TRUE or FALSE, or in arrays or 

references that contain logical values. 

 If an array or reference argument contains text or empty cells, those values are ignored. 

 If the specified range contains no logical values, XOR returns the #VALUE! error value. 

 You can use an XOR array formula to see if a value occurs in an array. 
 

 

 The result of XOR is TRUE when the number of TRUE inputs is odd and FALSE when the 

number of TRUE inputs is even. 

 

 

Example 

 
Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. 
 

 

 

AND function 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac More... 
 

Use the AND function, one of the logical functions, to determine if all conditions in a test are TRUE. 

Note: If you have a current version of Microsoft 365, then you can simply enter the formula in 

the top-left-cell of the output range, then press ENTER to confirm the formula as a dynamic 

array formula. Otherwise, the formula must be entered as a legacy array formula by first 

selecting the output range, entering the formula in the top-left-cell of the output range, and then 

pressing CTRL+SHIFT+ENTER to confirm it. Excel inserts curly brackets at the beginning 

and end of the formula for you. For more information on array formulas, see Guidelines and 

examples of array formulas. 

FALSE =XOR(3>12,4>6) 

FALSE Because both of the two tests evaluates to TRUE, FALSE 
is returned. 

Because all test results evaluate to FALSE, FALSE is 

returned. At least one of the test results must evaluate to 

TRUE to return TRUE. 

=XOR(3>0,2<9) 

Result Description Formula 

https://support.microsoft.com/en-us/office/logical-functions-reference-e093c192-278b-43f6-8c3a-b6ce299931f5
https://products.office.com/en-us/buy/compare-microsoft-office-products
https://support.microsoft.com/en-us/office/guidelines-and-examples-of-array-formulas-7d94a64e-3ff3-4686-9372-ecfd5caa57c7
https://support.microsoft.com/en-us/office/guidelines-and-examples-of-array-formulas-7d94a64e-3ff3-4686-9372-ecfd5caa57c7
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Description Formula 

Example 
 

 

 
 

Examples 

 
Here are some general examples of using AND by itself, and in conjunction with the IF function. 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

=AND(A2>1,A2<100) Displays   TRUE   if   A2   is   greater   than 

1 AND less than 100, otherwise it displays 

FALSE. 

=IF(AND(A2<A3,A2<100),A2,"The 

value is out of range") 

 
=IF(AND(A3>1,A3<100),A3,"The value 

is out of range") 

Displays the value in cell A2 if it’s less than 

A3 AND less than 100, otherwise it displays 

the message "The value is out of range". 

Displays the value in cell A3 if it is greater 

than 1 AND less than 100, otherwise it 

displays a message. You can substitute any 

message of your choice. 

 

Bonus Calculation 

 

Here is a fairly common scenario where we need to calculate if sales people qualify for a bonus 

using IF and AND. 

Technical Details 
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 =IF(AND(B14>=$B$7,C14>=$B$5),B14*$B$8,0) – IF Total Sales are greater than or equal 

(>=) to the Sales Goal, AND Accounts are greater than or equal to (>=) the Account Goal, then 

multiply Total Sales by the Bonus %, otherwise return 0. 
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EXPERIMENT-4 Date: 
 
 

Aim: Regression Analysis:  

Trendline, Slope and Intercept, Interpolation and Forecast,TheLINEST Function, 

Multilinear Regression, Polynomial Fit Functions, Residuals Plot, Slope and Tangent, Analysis Tool 

Pack. 

 

 
How to make a trendline in Excel 2010 

 

To add a trendline in Excel 2010, you follow a different route: 

 

1. On a chart, click the data series for which you want to draw a trendline. 

2. Under Chart Tools, go to the Layout tab > Analysis group, click Trendline and either: 

o Pick one of the predefined options, or 

o Click More Trendline Options…, and then choose the trendline type for your chart. 
 

 
 

How to insert multiple trendlines in the same chart 

 

Microsoft Excel allows adding more than one trendline to a chart. There are two scenarios that should be 

handled differently. 
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Add a trendline for each data series 

 

To put a trendline on a chart that has two or more data series, here's what you do: 

 

1. Right-click   the   data   points   of   interest   (blue   ones   in   this   example)   and   choose Add 

Trendline… from the context menu: 

 

2. This will open the Trendline Options tab of the pane, where you can choose the desired line type: 

 

3. Repeat the above steps for the other data series. 
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As    the    result,    each    data    series    will    have    its    own    trendline    of    the    matching    color: 

 
 

Alternatively, you can click the Chart Elements button, then click the arrow next to Trendline and choose 

the type you want. Excel will show a list of the data series plotted in your chart. You pick the needed one 

and click OK. 
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Forecast in Excel 

 

Forecasting is a special technique of making predictions for the future by using historical data as inputs and 

analyzing trends. 

 

This method is commonly used to make educated guesses on cash flows, plan budgets, anticipate future 

expenses or sales, and so on. However, forecasting doesn't tell the future definitively, it only shows 

probabilities. So, you should always double check the results before making a decision. 

 

Microsoft Excel offers a few different forecasting tools including built-in features, functions, and graphs. 

Depending in your needs, you can choose one of the following methods: 

 

 Exponential smoothing forecast - time series forecasting based on historical data with seasonal or 

other cycles. 

 Linear forecast - predicting future values using linear regression. 
 

 

How to forecast in Excel using exponential smoothing 

 

Exponential smoothing forecasting in Excel is based on the AAA version (additive error, additive trend and 

additive seasonality) of the Exponential Triple Smoothing (ETS) algorithm, which smoothes out minor 

deviations in past data trends by detecting seasonality patterns and confidence intervals. 

 

This forecasting method is best suited for non-linear data models with seasonal or other recurring 

patterns. It is available in Excel 2016, Excel 2019 and Excel for Office 365. 

 

You can do such a forecast with your own formulas or have Excel create a forecast sheet for you 

automatically. 

 

 
Create an exponential forecast sheet automatically. 

 

The Forecast Sheet feature introduced in Excel 2016 makes time series forecasting super-easy. Basically, 

you only need to appropriately organize the source data, and Excel will do the rest. 

 
Arranging data 

 

In your Excel worksheet, enter two data series into adjacent columns: 

 

 Time series - date or time entries that are observed sequentially at a regular interval like hourly, daily, 

monthly, yearly, etc. 

 Data values series - corresponding numeric values that will be predicted for future dates. 

 

It is important that your time series have equal intervals between the data points. For example, you can 

supply weekly intervals with values on every Monday, monthly intervals with values on the 1st day of every 

month, etc. 

https://www.ablebits.com/office-addins-blog/forecast-excel-linear-exponential-smoothing-forecasting-models/#exponential-smoothing-forecast
https://www.ablebits.com/office-addins-blog/forecast-excel-linear-exponential-smoothing-forecasting-models/#linear-regression-forecasting
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In theory, your time series can miss up to 30% of data points or have several entries with the same date or 

time, and Excel will still do the forecast correctly. However, it is recommended to summarize your data to 

get more accurate predictions. 

 

In this example, we will try to forecast sales for the next few years based on the following historical data. 

Please pay attention that column A contains dates (the 1st of every month) in a custom format that displays 

only the month and year. However, these are fully-functional dates, not text values. 

 

 
Creating a forecast sheet 

 

With the two data series in place, carry out the following steps to build a forecasting model: 

 

1. Select both data series. In most cases, it is sufficient to select just one cell in any of your series, 

and Excel picks up the rest of the data automatically. 

2. Go to the Data tab > Forecast group and click the Forecast Sheet button. 

 

3. The Create Forecast Worksheet window shows a forecast preview and asks you to choose: 

o Graph type: line (default) or column chart 

o End date for forecasting 
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4. When done, click the Create button. 

 

 
Excel immediately creates a new sheet containing a table with your original and predicted values as well as a 
chart that visually represents this data. 

 

The slope of the regression line is a measure of the steepness of the line. 

 
It’s a numeric value that tells us how two variables are correlated. It tells us how much the dependent 

variable will change in case there is a change in the independent variable. 

 
There are three ways to find the slope of the regression line for a given set of variables in Excel: 

 
 Using the SLOPE Function 

 
 Using an Excel Scatter chart 

 
In this tutorial, I show you how to calculate slope using each of the above three methods. 
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This Tutorial Covers: 

  What is Slope? An Overview 
 Method 1: Using the Excel SLOPE Function 

 o SLOPE Function Syntax in Excel 
o Points to Remember when Using the SLOPE Function in Excel 

 Method 2 – Using a Scatter Chart to get the Slope Value 

What is Slope? An Overview 

 
A Slope is a value that tells us how two values (usually called the x and y values) are related to each other. 

 
To give you a simple example, if you have the data about the height and yearly income of some people and 

you calculate the slope for this data, it will tell you whether there is a positive or negative correlation 

between these data points. 

 

 
The slope value can be positive or negative. 

https://trumpexcel.com/find-slope-excel/#What-is-Slope-An-Overview
https://trumpexcel.com/find-slope-excel/#Method-1-Using-the-Excel-SLOPE-Function
https://trumpexcel.com/find-slope-excel/#SLOPE-Function-Syntax-in-Excel
https://trumpexcel.com/find-slope-excel/#Points-to-Remember-when-Using-the-SLOPE-Function-in-Excel
https://trumpexcel.com/find-slope-excel/#Method-2-%E2%80%93-Using-a-Scatter-Chart-to-get-the-Slope-Value
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In our example, if the slope value is 138, which means that there is a positive correlation between height and 

the income of people. So if the height increases by 1 centimeter, the income is likely to increase by USD 

138. 

 
Apart from the slope, another thing you need to know about is the Intercept. 

Let me explain it with the equation: 

Y = Slope*X + Intercept 

 
In this equation, we have already calculated the slope, but to truly know what would be the Y value for a 

given X value, you also need to know the intercept. 

 
Thankfully, Excel has a formula for that as well, and I will cover how to calculate intercept in all the 

methods. 

 
Method 1: Using the Excel SLOPE Function 

The easiest way to calculate slope in Excel is to use the in-built SLOPE function. 

It finds the slope value of a given set of x-y coordinates in one step. 

 
While calculating slope manually could be hard, with the SLOPE function, you just need to give it the x and 

y values and it does all the heavy lifting in the backend. 

 
SLOPE Function Syntax in Excel 

The syntax for the slope function is: 

=SLOPE(y_vals, x_vals) 

 
Here, y_vals and x_vals each consist of an array or range of cells containing numeric dependent data values. 

 

Suppose you have the below dataset as shown below where I have the height (in cm) as X values and 

average annual income (in USD) as the Y values. 

Remember that you need to give the Y values as the first argument and X values as the second 

argument. If you do it the other way round, you will still get the result but it would be incorrect. 
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Below is the formula to calculate slope using this dataset: 

 
=SLOPE(B2:B11,A2:A11) 
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The above result tells me that from this dataset, I can assume that in case the height increases by 1 cm, the 

income would increase by USD 138.58. 

 
Another common statistical value that people often calculate when working with slope is to calculate 

the Intercept value. 

 
Just to refresh, the slope equation is something as shown below: 

 
Y = Slope*X + Intercept 

 
While we know the slope, we would also need to know the intercept value to make sure we can calculate Y 

values for any X value. 

 
This can easily be done using the below formula: 
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=INTERCEPT(B2:B11,A2:A11) 

 

 
With this, our equation for this dataset becomes: 

 
Y = 138.56*X + 65803.2 

 
So now, if I ask you what would be the income of anyone whose height is 165 cm, you can calculate the 

value easily. 

 
Y = 138.56*165 + 65803.2 

 

 

Points to Remember when Using the SLOPE Function in Excel 

Both slope and intercept values can be positive or negative 
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Here are a few points to remember when finding the slope of a regression line using the SLOPE function: 

 
 Arguments of the SLOPE function have to be numerical (DATE values are also accepted). In 

case any of the cells are blank or contains a text string, these would be ignored 

 
 In case there is ‘0’ in any cell/cells, it would be used in the calculation 

 
 There should be an equal number of x and y values, when used as input for the SLOPE 

function. In case you give it unequal sized ranges, you will get a #N/A error 

 There should be more than one set of points, otherwise the SLOPE function returns a #DIV! 

error 

Method 2 – Using a Scatter Chart to get the Slope Value 

If you prefer to visualize your data and the regression line, you can plot the data in a scatter chart and use it 

to find the slope and the intercept for the trend line (also called the line of best fit). 

 

Suppose you have the dataset as shown below and you want to find out the slope and intercept for this data: 

 

 
Below are the steps to do this: 

 
1. Select both X and Y data points (in our example, it would be the height and income column) 

 
2. Click on the ‘Insert’ tab in the ribbon 

https://trumpexcel.com/iferror-vlookup/
https://trumpexcel.com/scatter-plot-excel/
https://trumpexcel.com/trendline/


Spread Sheet for Engineers  

57 | P a g e 

 

 

 
 

3. Click on the ‘Insert scatter’ dropdown (under the Charts group) 

 
4. From the dropdown that appears, select the ‘Scatter chart’ option 

 

 

5. This will insert a scatter chart into your worksheet, displaying your x-y values as scatter 

points (as shown below) 
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6. Right-click on one of the scatter points, and select ‘Add Trendline’ from the context menu 

that appears. This will insert the trendline and also open the ‘Format Trendline’ pane in the 

right 
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7. In the Format Trendline pane, within the ‘Trendline Options’, select the ‘Display Equation on 

chart’ checkbox 
 

 

8. Close the Format Trendline pane 

 
The above steps would insert a scatter chart that has a trendline, and the trendline also has the slope and 

intercept equation. 
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In our example, we get the below equation: 

 
y = 138.56x + 65803 

 
Here: 

 
 138.56 is the slope of the regression line. 

 
 65803 is the intercept of the regression line. 

 
You can compare this with the values we got from the SLOPE and INTERCEPT functions (it’s the same 

value). 

 

 

While the formula method to calculate slope and intercept is easy, the benefit of using the scatter chart 

method is that you can visually see the distribution of the data points as well as the slope of the regression 

line. 

 
And in case you are anyway creating a scatter chart for your data, getting the slope value by adding a 

trendline would actually be faster than using the formulas. 

If the slope value is positive, you’ll see the trend line going up, and if the slope value is negative, then you 

will see the trend line going down. The steepness of the slope would be dependent on its slope value 
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So these are two really simple ways that you can use to calculate the slope and the intercept value of a data 

set in Excel. 

 

 

 

 

 
 

Lincet 

 

 

 
 

LINEST function 

 

Excel for Microsoft 365 Excel for Microsoft 365 for Mac More... 
 

This article describes the formula syntax and usage of the LINEST function in Microsoft Excel. Find links 

to more information about charting and performing a regression analysis in the See Also section. 

 

 

Description 

 
The LINEST function calculates the statistics for a line by using the "least squares" method to calculate a 

straight line that best fits your data, and then returns an array that describes the line. You can also 

combine LINEST with other functions to calculate the statistics for other types of models that are linear in 

the unknown parameters, including polynomial, logarithmic, exponential, and power series. Because this 

function returns an array of values, it must be entered as an array formula. Instructions follow the examples 

in this article. 

 

The equation for the line is: 

 

y = mx + b 

 

–or– 

 

y = m1x1 + m2x2 + ... + b 

 

if there are multiple ranges of x-values, where the dependent y-values are a function of the independent x- 

values. The m-values are coefficients corresponding to each x-value, and b is a constant value. Note that y, x, 

and m can be vectors. The array that the LINEST function returns is {mn,mn-1,...,m1,b}. LINEST can also 

return additional regression statistics. 

 

 

Syntax 

 
 LINEST(known_y's, [known_x's], [const], [stats])  
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The LINEST function syntax has the following arguments: 
 

 

Syntax 

 
 known_y's Required. The set of y-values that you already know in the relationship y = mx + 

b. 

 If the range of known_y's is in a single column, each column of known_x's is interpreted 

as a separate variable. 

 If the range of known_y's is contained in a single row, each row of known_x's is 

interpreted as a separate variable. 

 known_x's Optional. A set of x-values that you may already know in the relationship y = mx + 

b. 

 The range of known_x's can include one or more sets of variables. If only one variable is 

used, known_y's and known_x's can be ranges of any shape, as long as they have equal 

dimensions. If more than one variable is used, known_y's must be a vector (that is, a 

range with a height of one row or a width of one column). 

 If known_x's is omitted, it is assumed to be the array {1,2,3,...} that is the same size 

as known_y's. 

 const Optional. A logical value specifying whether to force the constant b to equal 0. 

 If const is TRUE or omitted, b is calculated normally. 

 If const is FALSE, b is set equal to 0 and the m-values are adjusted to fit y = mx. 

 stats Optional. A logical value specifying whether to return additional regression statistics. 

 If stats is TRUE, LINEST returns the additional regression statistics; as a result, the 

returned array is {mn,mn-1,...,m1,b;sen,sen-1,...,se1,seb;r2,sey;F,df;ssreg,ssresid}. 

 If stats is FALSE or omitted, LINEST returns only the m-coefficients and the constant b. 

 

The additional regression statistics are as follows. 
 

The standard error values for the coefficients m1,m2,...,mn. 

The standard error value for the constant b (seb = #N/A when const is FALSE). 

The coefficient of determination. Compares estimated and actual y-values, and ranges 

in value from 0 to 1. If it is 1, there is a perfect correlation in the sample — there is no 

difference between the estimated y-value and the actual y-value. At the other extreme, 

if the coefficient of determination is 0, the regression equation is not helpful in 

predicting a y-value. For information about how r2 is calculated, see "Remarks," later in 

this topic. 

The standard error for the y estimate. 

The F statistic, or the F-observed value. Use the F statistic to determine whether the 

observed relationship between the dependent and independent variables occurs by 

chance. 

The degrees of freedom. Use the degrees of freedom to help you find F-critical values 

in a statistical table. Compare the values you find in the table to the F statistic returned 

by LINEST to determine a confidence level for the model. For information about how 

se1,se2,...,sen 

seb 

r2 

 

 

 

 
sey 

F 

 

 

df 

Description Statistic 
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The following illustration shows the order in which the additional regression statistics are returned. 
 

 

 
Remarks 

 
 You can describe any straight line with the slope and the y-intercept: 

 

Slope (m): 

To find the slope of a line, often written as m, take two points on the line, (x1,y1) and (x2,y2); 

the slope is equal to (y2 - y1)/(x2 - x1). 

 

Y-intercept (b): 

The y-intercept of a line, often written as b, is the value of y at the point where the line crosses 

the y-axis. 

 

The equation of a straight line is y = mx + b. Once you know the values of m and b, you can 

calculate any point on the line by plugging the y- or x-value into that equation. You can also use 

the TREND function. 

 

 When you have only one independent x-variable, you can obtain the slope and y-intercept values 

directly by using the following formulas: 

 

Slope: 

=INDEX(LINEST(known_y's,known_x's),1) 

 

Y-intercept: 

=INDEX(LINEST(known_y's,known_x's),2) 

 

 The accuracy of the line calculated by the LINEST function depends on the degree of scatter in 

your data. The more linear the data, the more accurate the LINEST model. LINEST uses the 

method of least squares for determining the best fit for the data. When you have only one 

independent x-variable, the calculations for m and b are based on the following formulas: 

df is calculated, see "Remarks," later in this topic. Example 4 shows use of F and df. 

The regression sum of squares. 

The residual sum of squares. For information about how ssreg and ssresid are 

calculated, see "Remarks," later in this topic. 

ssreg 

ssresid 

Description Statistic 

https://support.microsoft.com/en-us/office/linest-function-84d7d0d9-6e50-4101-977a-fa7abf772b6d#bmexample4
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where x and y are sample means; that is, x = AVERAGE(known x's) and y = 

AVERAGE(known_y's). 

 

 The line- and curve-fitting functions LINEST and LOGEST can calculate the best straight line 

or exponential curve that fits your data. However, you have to decide which of the two results 

best fits your data. You can calculate TREND(known_y's,known_x's) for a straight line, 

or GROWTH(known_y's, known_x's) for an exponential curve. These functions, without 

the new_x's argument, return an array of y-values predicted along that line or curve at your 

actual data points. You can then compare the predicted values with the actual values. You may 

want to chart them both for a visual comparison. 

 In regression analysis, Excel calculates for each point the squared difference between the y-value 

estimated for that point and its actual y-value. The sum of these squared differences is called the 

residual sum of squares, ssresid. Excel then calculates the total sum of squares, sstotal. When 

the const argument = TRUE or is omitted, the total sum of squares is the sum of the squared 

differences between the actual y-values   and   the   average   of   the   y-values.   When 

the const argument = FALSE, the total sum of squares is the sum of the squares of the actual y- 

values (without subtracting the average y-value from each individual y-value). Then regression 

sum of squares, ssreg, can be found from: ssreg = sstotal - ssresid. The smaller the residual sum 

of squares is, compared with the total sum of squares, the larger the value of the coefficient of 

determination, r2, which is an indicator of how well the equation resulting from the regression 

analysis explains the relationship among the variables. The value of r2 equals ssreg/sstotal. 

 In some cases, one or more of the X columns (assume that Y’s and X’s are in columns) may 

have no additional predictive value in the presence of the other X columns. In other words, 

eliminating one or more X columns might lead to predicted Y values that are equally accurate. In 

that case these redundant X columns should be omitted from the regression model. This 

phenomenon is called “collinearity” because any redundant X column can be expressed as a sum 

of multiples of the non-redundant X columns. The LINEST function checks for collinearity and 

removes any redundant X columns from the regression model when it identifies them. Removed 

X columns can be recognized in LINEST output as having 0 coefficients in addition to 0 se 

values. If one or more columns are removed as redundant, df is affected because df depends on 

the number of X columns actually used for predictive purposes. For details on the computation 

of df, see Example 4. If df is changed because redundant X columns are removed, values of sey 

and F are also affected. Collinearity should be relatively rare in practice. However, one case 

where it is more likely to arise is when some X columns contain only 0 and 1 values as 

indicators of whether a subject in an experiment is or is not a member of a particular group. 

If const = TRUE or is omitted, the LINEST function effectively inserts an additional X column 

of all 1 values to model the intercept. If you have a column with a 1 for each subject if male, or 0 

if not, and you also have a column with a 1 for each subject if female, or 0 if not, this latter 

column is redundant because entries in it can be obtained from subtracting the entry in the “male 

indicator” column from the entry in the additional column of all 1 values added by 

the LINEST function. 

https://support.microsoft.com/en-us/office/linest-function-84d7d0d9-6e50-4101-977a-fa7abf772b6d#bmexample4
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 The value of df is calculated as follows, when no X columns are removed from the model due to 

collinearity: if there are k columns of known_x’s and const = TRUE or is omitted, df = n – k – 1. 

If const = FALSE, df = n - k. In both cases, each X column that was removed due to collinearity 

increases the value of df by 1. 

 When entering an array constant (such as known_x's) as an argument, use commas to separate 

values that are contained in the same row and semicolons to separate rows. Separator characters 

may be different depending on your regional settings. 

 Note that the y-values predicted by the regression equation may not be valid if they are outside 

the range of the y-values you used to determine the equation. 

 The underlying algorithm used in the LINEST function is different than the underlying 

algorithm used in the SLOPE and INTERCEPT functions. The difference between these 

algorithms can lead to different results when data is undetermined and collinear. For example, if 

the data points of the known_y's argument are 0 and the data points of the known_x's argument 

are 1: 

 LINEST returns a value of 0. The algorithm of the LINEST function is designed to 

return reasonable results for collinear data and, in this case, at least one answer can be 

found. 

 SLOPE and INTERCEPT return     a      #DIV/0!      error.      The      algorithm      of 

the SLOPE and INTERCEPT functions is designed to look for only one answer, and in 

this case there can be more than one answer. 

 In addition to using LOGEST to calculate statistics for other regression types,   you can 

use LINEST to calculate a range of other regression types by entering functions of the x and y 

variables as the x and y series for LINEST. For example, the following formula: 

 

=LINEST(yvalues, xvalues^COLUMN($A:$C)) 

 

works when you have a single column of y-values and a single column of x-values to calculate 

the cubic (polynomial of order 3) approximation of the form: 

 

y = m1*x + m2*x^2 + m3*x^3 + b 

 

You can adjust this formula to calculate other types of regression, but in some cases it requires 

the adjustment of the output values and other statistics. 

 

 The F-test value that is returned by the LINEST function differs from the F-test value that is 

returned by the FTEST function. LINEST returns the F statistic, whereas FTEST returns the 

probability. 

 

 

 

 

Example 1 - Slope and Y-Intercept 

 

Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 

https://support.microsoft.com/en-us/office/ftest-function-4c9e1202-53fe-428c-a737-976f6fc3f9fd
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Known y Known x  

1 0 

9 4 

5 2 

7 3 

Result (slope) Result (y-intercept) 

2 1 

Formula (array formula in cells A7:B7)  

=LINEST(A2:A5,B2:B5,,FALSE)  

 

 

Example 2 - Simple Linear Regression 

 

Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 

 

Month Sales 

1 $3,100 

2 $4,500 

3 $4,400 

4 $5,400 

5 $7,500 

6 $8,100 

Formula Result 

=SUM(LINEST(B1:B6, $11,000 

A1:A6)*{9,1})  

 Calculates the estimate of the sales in the ninth month, 

 based on sales in months 1 through 6. 

 

 
Example 3 - Multiple Linear Regression 

 

Copy the example data in the following table, and paste it in cell A1 of a new Excel worksheet. For formulas 

to show results, select them, press F2, and then press Enter. If you need to, you can adjust the column widths 

to see all the data. 
 

Floor space (x1) Offices Entrances Age Assessed 

(x2) (x3) (x4) value (y) 
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Floor space (x1) Offices Entrances Age Assessed  

 (x2) (x3) (x4) value (y) 

2310 2 2 20 $142,000 

2333 2 2 12 $144,000 

2356 3 1.5 33 $151,000 

2379 3 2 43 $150,000 

2402 2 3 53 $139,000 

2425 4 2 23 $169,000 

2448 2 1.5 99 $126,000 

2471 2 2 34 $142,900 

2494 3 3 23 $163,000 

2517 4 4 55 $169,000 

2540 2 3 22 $149,000 

-234.2371645     

13.26801148     

0.996747993     

459.7536742     

1732393319     

Formula (dynamic array formula     

entered in A19)     

=LINEST(E2:E12,A2:D12,TRUE,TRUE)     

 

 

 

How to Fit a Polynomial Curve in Excel (Step-by-Step) 
 

 

You can use the LINEST() function in Excel to fit a polynomial curve with a certain degree. 

 

For example, you can use the following basic syntax to fit a polynomial curve with a degree of 3: 
 

 =LINEST(known_ys, known_xs^{1, 2, 3})  
 

The function returns an array of coefficients that describes the polynomial fit. 

 

The following step-by-step example shows how to use this function to fit a polynomial curve in Excel. 

Step 1: Create the Data 
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First, let’s create some data to work with: 
 

Step 2: Fit a Polynomial Curve 

 

Next, let’s use the LINEST() function to fit a polynomial curve with a degree of 3 to the dataset: 
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Step 3: Interpret the Polynomial Curve 

 

Once we press ENTER, an array of coefficients will appear: 
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Using these coefficients, we can construct the following equation to describe the relationship between x and 

y: 

 

y = .0218x3 – .2239x2 – .6084x + 30.0915 

 

We can also use this equation to calculate the expected value of y, based on the value of x. 

For example, suppose x = 4. The expected value of y would be: 

y = .0218(4)3 – .2239(4)2 – .6084(4) + 30.0915 = 25.47 

 

How to Create a Residual Plot in Excel 
 

 

A residual plot is a type of plot that displays the fitted values against the residual values for a regression 

model. 

 

This type of plot is often used to assess whether or not a linear regression model is appropriate for a given 

dataset and to check for heteroscedasticity of residuals. 

https://www.statology.org/understanding-heteroscedasticity-in-regression-analysis/
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This tutorial explains how to create a residual plot for a simple linear regression model in Excel. 

 

How to Create a Residual Plot in Excel 

 

Use the following steps to create a residual plot in Excel: 

 

Step 1: Enter the data values in the first two columns. For example, enter the values for the predictor 

variable in A2:A13 and the values for the response variable in B2:B13. 
 

 

Step 2: Create a scatterplot. Highlight the values in cells A2:B13. Then, navigate to the INSERT tab along 

the top ribbon. Click on the first option for Scatter within the Charts area. 
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The following chart will appear: 
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Step 3: Display trend line equation on the scatterplot. Click “Add Chart Elements” from the DESIGN tab, 

then “Trendline”, and then “More Trendline Option. Leave “Linear” selected and check “Display Equation 

on Chart.” Close the “Format Trendline” panel. 

 

The trend line equation will now be displayed on the scatterplot: 
 

 

Step 4: Calculate the predicted values. Enter the trendline equation in cell C2, replacing “x” with “A1” 

like so: 
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Then, click cell C2 and double-click the small “Fill Handle” at the bottom right of the cell. This will copy 

the formula in cell C2 to the rest of the cells in the column: 
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Step 5: Calculate the residuals. Enter B2-C2 in cell D2. Then, click cell D2 and double-click the small “Fill 

Handle” at the bottom right of the cell. This will copy the formula in cell D2 to the rest of the cells in the 

column: 
 

 

Step 6: Create the residual plot. Highlight cells A2:A13. Hold the “Ctrl” key and highlight cells D2:D13. 

Then, navigate to the INSERT tab along the top ribbon. Click on the first option for Scatter within 

the Charts area. The following chart will appear: 
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This is the residual plot. The x-axis displays the fitted values and the y-axis displays the residuals. 

Feel free to modify the title, axes, and gridlines to make the plot look more visually appealing: 

Suitable Ways to Find Slope of Tangent Line in Excel 

In this article, you will see two easy methods to find the slope of a tangent line in Excel. The first method 

will discuss the use of the SLOPE function of Excel. In the second method, I will insert the available data 

into an Excel chart and then find the slope from the equation. 

To illustrate my article further, I will use the following sample data set. 
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1. Apply SLOPE Function to Find Slope of Tangent Line 

In the first method, I will apply the SLOPE function of Excel for determining the slope of a tangent line. 

By using the function, you can calculate the slope in Excel. The function will take the y-axis and x- 

axis values of an equation as the inputs and then show the slope as a numerical value. Go through the 

following steps for a better understanding. 

Steps: 

 First of all, I will assume some values for the X variable of the equation in cell C4. 
 Then, to calculate the values of the Y variable, insert the following formula in cell C7. 

 =B7^2+1 

https://www.exceldemy.com/excel-slope-function/
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 Secondly, press Enter and use AutoFill to get the desired result for the lower cells as well. 

 

 

 Thirdly, to find the slope, make an extra field in cell C13 and type the following formula. 

=SLOPE(C7:C11,B7:B11) 

https://support.microsoft.com/en-us/office/fill-data-automatically-in-worksheet-cells-74e31bdd-d993-45da-aa82-35a236c5b5db


Spread Sheet for Engineers  

79 | P a g e 

 

 

 
 

 Finally, press Enter to get the slope that is 6. 
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Read More: How to Find the Slope of a Line in Excel (5 Easy Ways) 
 

2. Insert Data into Excel Chart to Find Slope of Tangent Line 

In the second method, instead of using any function, I will insert the available data set for making 

an Excel chart. After making the chart, I will find the slope from the trendline. Let’s follow the instruction 

below to find the slope of the tangent line! 

Steps: 

 Firstly, calculate the values of the y-axis for the equation of cell C4 just like the previous method. 
 Then, select the data range B6:C11 and go to the Insert tab of the ribbon. 

 Afterward, from the Charts group, select Insert Scatter (X,Y) or Bubble Chart. 

 

 

 Secondly, from the dropdown, choose Scatter with Smooth Lines. 

https://www.exceldemy.com/how-to-find-the-slope-of-a-line-in-excel/
https://www.exceldemy.com/find-slope-of-trendline-in-excel/
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 Thirdly, you will see the chart with the required data in your Excel sheet. 

 After that, select your Excel chart and choose the Chart Elements icon which is on the top right 

corner of the chart. 
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 Fourthly, from the Chart Elements command select the Trendline dropdown and from there 

choose More Options. 
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 Consequently, you will see the Format Trendline window pane after the previous step and then 

mark the option Display Equation on chart. 
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 Finally, you will see the consequent equation for this tangent line is y = 6x – 6, and by comparing the 

equation with y = mx + c, you can see the slope of this line is 6. 
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NOTES 

 While inserting the data range in the SLOPE function formula, remember to insert the values of 

the y-axis in the first place. 

 Insert the proper data range while making the Excel chart. 

 The SLOPE function returns #DIV/0! error when any cell of X-coordinates or Y-coordinates is 

empty. 
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EXPERIMENT-5 Date: 

 

Aim: Iterative Solutions Using Excel: Using Goal Seek in Excel, Using the Solver to Find Roots, 

Finding Multiple Roots, Optimization Using the Solver, Minimization Analysis, Nonlinear Regression 

Analysis. 

Quadratic Equation 

 

A quadratic equation is of the form ax2 + bx + c = 0 where a ≠ 0. A quadratic equation can be solved by 

using the quadratic formula. You can also use Excel's Goal Seek feature to solve a quadratic equation. 

1. For example, we have the formula y = 3x2 - 12x + 9.5. It's easy to calculate y for any given x. For x = 1, y 

= 0.5 

 

2. For x = 2, y = -2.5 
 

3. But what if we want to know x for any given y? For example, y = 24.5. We need to solve 3x2 - 12x + 9.5 = 

24.5. We can solve the quadratic equation 3x2 - 12x + 9.5 - 24.5 = 0 by using the quadratic formula. 

3x2 -12x-15=0 

a=3,b=-12,c=-15 

D = b2- 4ac = (-12)2 - 4 * 3 * -15 = 144 + 180 = 324 

x = 
-b + √D 

or x = 
-b - √D  

2a 2a 

x = 
12 + √324 

or x = 
12 - √324  

6 6 
12 + 18  12 - 18  

6 
or x = 

6
 

 

x = 5 or x = -1 

 
4. You can use Excel's Goal Seek feature to obtain the exact same result. On the Data tab, in the Forecast 

group, click What-If Analysis. 

x = 
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5. Click Goal Seek. 
 

The Goal Seek dialog box appears. 

6. Select cell B2. 

7. Click in the 'To value' box and type 24.5 

8. Click in the 'By changing cell' box and select cell A2. 

9. Click OK. 
 

Result. 
 

Note: Excel returns the solution x = 5. Excel finds the other solution if you start with an x-value closer to x = 

-1. For example, enter the value 0 into cell A2 and repeat steps 5 to 9. To find the roots, set y = 0 and solve 

the quadratic equation 3x2 - 12x + 9.5 = 0. In this case, set 'To value' to 0. 

 

Creating a quadratic equation in Excel 

 

A quadratic equation should at least have one squared variable. To do this, you can simply multiply the 

variable by itself,   calculate   he   2nd power   of   the   variable   using   the   power   operator   ^   or   use 

the POWER function as in our example. 

https://www.spreadsheetweb.com/excel-power-function/
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The other important part is to refer a cell as variable, x. Our formula uses named range x and y for the 

unknown variables and the formula result respectively (x is C7 and y is D7). 

 

Note: Although adding y into the calculation isn't necessary if you always set it 0, we included it in our 

example for versatility. 

 

Using Goal Seek to solve quadratic equations in Excel 

 

Once the formula is ready in your spreadsheet, it is time to use Goal Seek to solve the quadratic function. 

Follow the steps below to find one of the variables of the equation: 

1. Select the cell that contains the formula. 

2. Open the Goal Seek dialog in Data > Data Tools > What-If Analysis > Goal Seek 

3. Set cell is the formula cell (It should be automatically selected) 

4. To value should be 0, which is the right end of the equation. 

5. Select the cell of the x value to the By changing cell 

6. Click OK to start Goal Seek 

 

 

7. After Excel finished the Goal Seek execution, the Goal Seek Status dialog will display the calculated 

value 

5x² + 6x + 1 = 0 => =5*POWER(x,2) + 6*x + 1 - y 
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8. Click OK to close the dialog 

 

 
Results of Goal Seek 

 

Although the process is pretty straightforward, there are some downsides to using Goal Seek. As you may 

have noticed in our screenshots, Goal Seek may fail to find the exact value you want. For example, in our 

example we wanted Goal Seek to find a value that makes our formula 0. However, the value makes the 

formula return a number close to 0, 0.000121893. 

If you check the x value, you will see a value very close to -0.2, -0.199969528007691. You need to manually 

enter -0.2 to see the formula return 0. 

This difference comes from calculation logic of Goal Seek. Goal Seek continues searching a certain number 

of times until it finds a value closer to the target value within the precision limits specified. The default 

limits for the iteration number and precision value are 100 and 0.001. You can adjust these from File > 

Options > Formulas. 
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Note: Decrease the Maximum Change value to increase the precision. 

Another important point while using Goal Seek is that you need to choose (guess) a starting point for Goal 

Seek. Goal Seek finds a single variable, but a quadratic function can have 2 variable options. We found - 

value when we set 0 to x. If you're satisfied with the results, you can change the x and run 

Goals Seek again. For example, setting 10 to x, and running Goal Seek finds another x value, -1. 
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Step 1 

 

Click "File" from Excel's menu bar. 

 

Step 2 

 

Click "Options." The "Excel Options" window will open. 

 

Step 3 

 

Click "Add-Ins" in the left pane. Click "Solver Add-in" from the right pane. 

 

Step 4 

 

Click the "Go" button. The "Add-Ins" dialog box will open. 

 

Step 5 

 

Check the box next to "Solver Add-in." Click "OK." 

 

Step 6 

 

Type your equation into a cell, using a second cell as a reference. For instance, if your equation is "4x^3 + 

2x^2 - 87 = -1," type into cell A1, "=4 * A2^3 + 2 * A2^2 - 87." 

 

Step 7 

 

Click on the "Data" ribbon. 

 

Step 8 

 

Click "Solver" from the "Analysis" tab. The "Solver Parameters" window will open. 
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Step 9 

 

Enter the reference of the cell into which you typed the formula in the "Set Objective:" box. In this example, 

type "A1." 

 

Step 10 

 

Click the "Value of:" button. 

 

Step 11 

 

Enter your target value in the "Value Of:" box. In this example, type "-1." 

 

Step 12 

 

Type the formula's reference cell in the "By Changing Variable Cells:" box. In this example, type "A2." 

 

Step 13 

 

Click "Solve." Excel will change both cells accordingly. In this example, cell A1 will change to "-1.00007," 

which is very close to "-1." Cell A2 will change to "2.623573," which is a root of the equation. 

 

Optimization with Excel Solver 
 

 Previous Page 

Next Page   

Solver is a Microsoft Excel add-in program you can use for optimization in what-if analysis. 

According to O'Brien and Marakas, optimization analysis is a more complex extension of goal-seeking 

analysis. Instead of setting a specific target value for a variable, the goal is to find the optimum value for one 

or more target variables, under certain constraints. Then, one or more other variables are changed repeatedly,  

subject to the specified constraints, until you discover the best values for the target variables. 

In Excel, you can use Solver to find an optimal value (maximum or minimum, or a certain value) for a 

formula in one cell called the objective cell, subject to certain constraints or limits, on the values of other 

formula cells on the worksheet. 

This means that the Solver works with a group of cells called decision variables that are used in computing 

the formulas in the objective and constraint cells. Solver adjusts the values in the decision variable cells to 

satisfy the limits on constraint cells and produce the result you want for the objective cell. 

You can use Solver to find optimal solutions for diverse problems such as − 

 Determining the monthly product mix for a drug manufacturing unit that maximizes the 

profitability. 

 Scheduling workforce in an organization. 

 Solving transportation problems. 

 Financial planning and budgeting. 

https://www.tutorialspoint.com/excel_data_analysis/what_if_analysis_with_goal_seek.htm
https://www.tutorialspoint.com/excel_data_analysis/importing_data_into_excel.htm
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Activating Solver Add-in 

Before you proceed with finding solution for a problem with Solver, ensure that the Solver Add-in is 

activated in Excel as follows − 

 Click the DATA tab on the Ribbon. The Solver command should appear in the Analysis group 

as shown below. 

 

In case you do not find the Solver command, activate it as follows − 

 Click the FILE tab. 

 Click Options in the left pane. Excel Options dialog box appears. 

 Click Add-Ins in the left pane. 

 Select Excel Add-Ins in the Manage box and click Go. 

 

The Add-Ins dialog box appears. Check Solver Add-in and click Ok. Now, you should be able to find the 

Solver command on the Ribbon under the DATA tab. 
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Solving Methods used by Solver 

You can choose one of the following three solving methods that Excel Solver supports, based on the type of 

problem − 

LP Simplex 

Used for linear problems. A Solver model is linear under the following conditions − 

 The target cell is computed by adding together the terms of the (changing cell)*(constant) 

form. 

 Each constraint satisfies the linear model requirement. This means that each constraint is 

evaluated by adding together the terms of the (changing cell)*(constant) form and comparing 

the sums to a constant. 

Generalized Reduced Gradient (GRG) Nonlinear 

Used for smooth nonlinear problems. If your target cell, any of your constraints, or both contain references 

to changing cells that are not of the (changing cell)*(constant) form, you have a nonlinear model. 

Evolutionary 

Used for smooth nonlinear problems. If your target cell, any of your constraints, or both contain references 

to changing cells that are not of the (changing cell)*(constant) form, you have a nonlinear model. 

Understanding Solver Evaluation 

The Solver requires the following parameters − 

 Decision Variable Cells 

 Constraint Cells 

 Objective Cells 
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 Solving Method 

Solver evaluation is based on the following − 

 The values in the decision variable cells are restricted by the values in the constraint cells. 

 The calculation of the value in the objective cell includes the values in the decision variable 

cells. 

 Solver uses the chosen Solving Method to result in the optimal value in the objective cell. 

Defining a Problem 

Suppose you are analyzing the profits made by a company that manufactures and sells a certain product. You 

are asked to find the amount that can be spent on advertising in the next two quarters subject to a maximum 

of 20,000. The level of advertising in each quarter affects the following − 

 The number of units sold, indirectly determining the amount of sales revenue. 

 The associated expenses, and 

 The profit. 

You can proceed to define the problem as − 

 Find Unit Cost. 

 Find the advertising cost per Unit. 

 Find Unit Price. 

 

Next, set the cells for the required calculations as given below. 
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As you can observe, the calculations are done for Quarter1 and Quarter2 that are in consideration are − 

 No. of units available for sale in Quarter1 is 400 and in Quarter2 is 600 (cells – C7 and D7). 

 The initial values for advertising budget are set as 10000 per Quarter (Cells – C8 and D8). 

 No. of units sold is dependent on the advertising cost per unit and hence is budget for the 

quarter / Adv. Cost per unit. Note that we have used the Min function to take care to see that 

the no. of units sold in <= no. of units available. (Cells – C9 and D9). 

 Revenue is calculated as Unit Price * No. of Units sold (Cells – C10 and D10). 

 Expenses is calculated as Unit Cost * No. of Units Available + Adv. Cost for that quarter 

(Cells – C11 and D12). 

 Profit is Revenue – Expenses (Cells C12 and D12). 

 Total Profit is Profit in Quarter1 + Profit in Quarter2 (Cell – D3). 

Next, you can set the parameters for Solver as given below − 

As you can observe, the parameters for Solver are − 

 Objective cell is D3 that contains Total Profit, which you want to maximize. 

 Decision Variable cells are C8 and D8 that contain the budgets for the two quarters – Quarter1 

and Quarter2. 

 There are three Constraint cells - C14, C15 and C16. 

o Cell C14 that contains total budget is to set the constraint of 20000 (cell D14). 

o Cell C15 that contains the no. of units sold in Quarter1 is to set the constraint of 

<= no. of units available in Quarter1 (cell D15). 

o Cell C16 that contains the no. of units sold in Quarter2 is to set the constraint of 

<= no. of units available in Quarter2 (cell D16). 
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Solving the Problem 

The next step is to use Solver to find the solution as follows − 

Step 1 − Go to DATA > Analysis > Solver on the Ribbon. The Solver Parameters dialog box appears. 
 

Step 2 − In the Set Objective box, select the cell D3. 

Step 3 − Select Max. 

Step 4 − Select range C8:D8 in the By Changing Variable Cells box. 
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Step 5 − Next, click the Add button to add the three constraints that you have identified. 

Step 6 − The Add Constraint dialog box appears. Set the constraint for total budget as given below and click 

Add. 
 

Step 7 − Set the constraint for total no. of units sold in Quarter1 as given below and click Add. 



Spread Sheet for Engineers  

99 | P a g e 

  

 

 

Step 8 − Set the constraint for total no. of units sold in Quarter2 as given below and click OK. 
 

The Solver Parameters dialog box appears with the three constraints added in box –Subject to the 

Constraints. 

Step 9 − In the Select a Solving Method box, select Simplex LP. 
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Step 10 − Click the Solve button. The Solver Results dialog box appears. Select Keep Solver Solution and 

click OK. 
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The results will appear in your worksheet. 
 

As you can observe, the optimal solution that produces maximum total profit, subject to the given 

constraints, is found to be the following − 

 Total Profit – 30000. 

 Adv. Budget for Quarter1 – 8000. 

 Adv. Budget for Quarter2 – 12000. 

Stepping through Solver Trial Solutions 

You can step through the Solver trial solutions, looking at the iteration results. 

Step 1 − Click the Options button in the Solver Parameters dialog box. 

The Options dialog box appears. 

Step 2 − Select the Show Iteration Results box and click OK. 
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Step 3 − The Solver Parameters dialog box appears. Click Solve. 

Step 4 − The Show Trial Solution dialog box appears, displaying the message - Solver paused, current 

solution values displayed on worksheet. 
 

As you can observe, the current iteration values are displayed in your working cells. You can either stop the 

Solver accepting the current results or continue with the Solver from finding solution in further steps. 

Step 5 − Click Continue. 

The Show Trial Solution dialog box appears at every step and finally after the optimal solution is found, 

Solver Results dialog box appears. Your worksheet is updated at every step, finally showing the result 

values. 

Saving Solver Selections 

You have the following saving options for the problems that you solve with Solver − 

 You can save the last selections in the Solver Parameters dialog box with a worksheet by 

saving the workbook. 

 Each worksheet in a workbook can have its own Solver selections, and all of them will be 

saved when you save the workbook. 

 You can also define more than one problem in a worksheet, each with its own Solver 

selections. In such a case, you can load and save problems individually with the Load/Save in 

the Solver Parameters dialog box. 

o Click the Load/Save button. The Load/Save dialog box appears. 
o To save a problem model, enter the reference for the first cell of a vertical range 

of empty cells in which you want to place the problem model. Click Save. 
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o The problem model (the Solver Parameters set) appears starting at the cell that you have given as the 

reference. 

 
o To load a problem model, enter the reference for the entire range of cells that contains the problem 

model. Then, click on the Load button. 

What Is Non-linear Regression In Excel? 

 
Non-linear regression in Excel is a statistical method used to find the nonlinear relationship between one 

dependent variable and independent continuous variables. Users can use the non-linear regression in a 

worksheet to fit the data to a model and represent it as a mathematical equation. 

For example, the table below shows the ad counts and the sales they generated. 
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Suppose the requirement is to calculate nonlinear regression in Excel for the above data. Then, we can use 
the Scatter plot from the Insert tab to achieve the required outcome. 

 

The ad count is the independent variable, and sales are the dependent variable in the above example. 
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And plotting a Scatter chart for the two variables and inserting a linear trendline, as shown in the first plot, 

shows a nonlinear relationship between the two parameters. In other words, the sales do not vary linearly 

with the ad count. 

 
Thus, we must choose the appropriate trendline to achieve the required nonlinear regression curve in 

Excel. In this case, we pick the Exponential trendline, as shown in the second plot. And hence, we obtain 

the exponent-based nonlinear regression equation relating the two specified variables. 
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o Download Template 
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 Key Takeaways  
 
 

 

Explanations & Uses 

 
Nonlinear regression in Excel statistically generates a curve depicting the nonlinear relationship between the 

specified variables or parameters. And Excel uses the nonlinear least square regression method to calculate 

nonlinear regression equations. 

 
The technique is more accurate and offers flexibility, allowing one to estimate diverse curves with complex 

equations that best fit the given data. 

 
Furthermore, this regression method helps evaluate if the predicted model fits the given data well and 

satisfies the analysis assumptions. 

 
The uses of non-linear regression in Excel are as follows: 

 The non-linear regression in Excel is a regression technique. It exhibits the nonlinear relationship 

between the response (dependent variable) and predictors (independent variables). 

 Users can use the nonlinear regression method to evaluate if the regression line fits the data. It helps 

review the relationship between the dependent variable and one or more independent variables and 

reckon how well the model fits the data. 

 We can use the Trendline Options from the Trendline Format window to determine the trendline 

curve that best fits the model to the data. And we can use the above mentioned option, LINEST(), 

or Regression from the Data Analysis ToolPak to obtain the nonlinear regression equation. 

https://www.excelmojo.com/non-linear-regression-in-excel/#h-what-is-non-linear-regression-in-excel
https://www.excelmojo.com/non-linear-regression-in-excel/#Explanations-%26-Uses
https://www.excelmojo.com/non-linear-regression-in-excel/#How-To-Use-Non-linear-Regression-In-Excel
https://www.excelmojo.com/non-linear-regression-in-excel/#Examples
https://www.excelmojo.com/non-linear-regression-in-excel/#Example--1
https://www.excelmojo.com/non-linear-regression-in-excel/#Example--2
https://www.excelmojo.com/non-linear-regression-in-excel/#Example--3
https://www.excelmojo.com/non-linear-regression-in-excel/#Important-Things-To-Note
https://www.excelmojo.com/non-linear-regression-in-excel/#Frequently-Asked-Questions
https://www.excelmojo.com/non-linear-regression-in-excel/#Download-Template
https://www.excelmojo.com/non-linear-regression-in-excel/#Recommended-Articles
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 Financial modeling and price fluctuations over time. 
 Logistic price variation model for estimating untouched market prices. 

 Predicting and forecasting in agriculture, finance, AI, and machine learning domains. 

 Dose-response research in biological sciences. 

 

How To Do Non-linear Regression In Excel? 

 
We can use non-linear regression in Excel by following the below steps: 

 
1. Plot a Scatter plot for the given data from the Insert tab. 

2. Insert a linear trendline to confirm the nonlinear relationship between the given variables. 

3. Once confirmed, pick the best-fitting trendline to obtain the required Excel nonlinear regression 

formula or equation. 

4. Thus, now we can perform the required nonlinear regression analysis. 

 

Click on a cell in the table of dependent and independent variables’ data or select the entire table range. And 

then, select the Insert tab – Pick the Scatter (X, Y) or Bubble Chart option – Choose the Scatter chart. 
 

[Alternatively, we can click on a cell in the table of dependent and independent variables’ data or select the 

entire table range. And then, select the Insert tab – Pick Recommended Charts option. 
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The Insert Chart window opens. 

 
Go to All Charts tab – Pick X Y (Scatter) chart – Choose Scatter chart – Pick the appropriate Scatter chart 

from the provided options. 
 

And clicking OK will give us the Scatter chart to calculate nonlinear regression in Excel and perform the 

required analysis.] 
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And then, click the Chart Elements option – Enable the Trendline option to confirm the nonlinear relation 

between the two variables. 
 

Next, click the Chart Elements option – Click Trendline right arrow – Pick More Options. 
 

The Format Trendline pane will open, where we can set the appropriate settings to achieve the nonlinear 

regression curve in Excel with the formula required for analysis. 
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Let us see the above steps in detail with an example. 

 
#Basic Example 

 
The table below shows the observations of two parameters, X and Y. 



Spread Sheet for Engineers  

110 | P a g e 

 

 

 
Suppose the requirement is to confirm the non-linear relationship between the two variables. Then, the steps 
are as follows: 

 
Step 1: To start with, click on a cell in the given table, and then, follow the path Insert – Scatter (X, Y) or 

Bubble Chart – Scatter chart to visualize the given data in a chart format. 

 

Step 2: Next, click the chart area to enable the Chart Elements option, and then, check the Trendline box. 
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We see the trendline is linear. But the data points do not align with the linear trendline. It implies that the 
relationship between X and Y is nonlinear. 

 
Next, we shall find the trendline that best fits our model. 

 
Step 3: Then, click the Chart Elements option and uncheck the Trendline box. And click 

the Trendline right arrow to choose More Options from the list. 

 

Step 4: The Format Trendline window opens, where we must try every option to determine the appropriate 

trendline. In this case, the Logarithmic curve best fits our model to the data. 
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Next, scroll down the Format Trendline pane and check the option to display the Excel nonlinear 
regression formula or equation in the chart area. 

 

Step 5: Now, click the Chart Elements option and check the Axis Titles option. 
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Step 6: Next, double-click the chart title and axis titles’ elements in the chart area, one at a time. And update 
them, as shown below. 

 

Thus, the final Scatter plot gives the non-linear regression in Excel for the given data will be depicted below. 
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Examples 

 
Check out the following non-linear regression in Excel examples to use it effectively. 

 
Example #1 

 
The table below contains the trial results of an experiment involving one independent and one dependent 

parameter. 
 

Suppose the requirement is to determine the non-linear regression in Excel for the above data. Then, the 

steps are as follows: 

 

Step 1: First, select the cell range B1:C11 and then, follow the path Insert – Scatter (X, Y) or Bubble 

Chart – Scatter chart. 
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Step 2: Next,   click Chart Elements – Trendline right   arrow – More   Options to open   the Format 
Trendline window. 

 

Step 3: Then, pick the Power curve under the Trendline Options, as it helps to fit the model to the given 

data in the best way possible. 
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Step 4: Now, check the options to display the nonlinear regression equation and the R-squared value in the 
chart area. 

 

Step 5: Next, click Chart Elements – Axis Titles. 
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Finally, double-click the chart and axis titles elements, one at a time, to update them in the chart area. 

 

The R-squared value of 0.999 indicates that the model best fits the given data. And we can use the power 

equation for nonlinear regression analysis, with x in the expression representing the independent parameter 

and y, the dependent parameter. 
 

Example #2 

 
The table below contains a list of X and Y values. 
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Suppose we must evaluate the non-linear regression in Excel for the above data. Then, the steps are as 
follows: 

 
Step 1: First, click on a cell in the given table, and then, follow the path Insert – Scatter (X, Y) or Bubble 

Chart – Scatter chart to visualize the given data in a chart format. 
 

And clicking Chart Elements – Trendline shows a linear line, which indicates that the relationship between 

the two parameters is nonlinear. 
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Step 2: Next, uncheck the Trendline option and then, click the Trendline right arrow to pick More 

Options. 
 

The Format Trendline window will open, where we must check every trendline option to identify the best 

curve fitting the given data into a model. 
 

In this example, we find the best fit with the Polynomial curve with the Order set as 6. We can click the 

drop-down buttons to increase and decrease the order, as per our requirement. 
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And check the option to display the nonlinear regression equation. 

 

Step 3: Next, update the chart and axis titles as explained in the previous section to obtain the below Scatter 

plot for non-linear regression in Excel for the given X and Y values. 
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We shall now see how to use the excel function LINEST for nonlinear regression in Excel. The function 
will help us determine the variable coefficients in the nonlinear regression equation. 

 
Sometimes, displaying the nonlinear regression equation from the Format Trendline window shows the 

coefficients up to one or two significant digits. It limits the analysis accuracy to the same number of 

significant digits. 

 
Also, we may require to show the equation in the worksheet. And in such a case, when we update the source 

data, the equation does not get updated. 

 
But when using the function LINEST for nonlinear regression in Excel, the coefficient accuracy will be 

for more significant digits. And when we update the source data, the coefficients also get updated 

automatically, as the function works with the given datasets. 

 
Step 4: Now, we shall introduce a table to determine the nonlinear regression equation coefficients using 

the LINEST(). 
 

Step 5: Next, select the cell range K3:Q3. 

https://www.excelmojo.com/linest-excel-function/
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And enter the LINEST(). 

 
=LINEST((B2:B11),(A2:A11)^{1,2,3,4,5,6},TRUE,FALSE) 

 

Next, press Ctrl + Shift + Enter to apply the expression as an array formula in excel. 
 

The LINEST() determines a line’s statistics using the least squares technique to obtain a line that fits the 

given data in the best way possible. And it returns an array of values describing the line. 
 

The function accepts the known Y value range and the   known X value   range   to   the   power   of 

array {1,2,3,4,5,6} as we require six coefficients. And it takes two logical values to calculate the constant c 

normally and return the coefficients and constant c, respectively. 

 
Further, we select seven cells to display the resulting array containing six coefficients and a constant. 

 
So, thus we obtain the required coefficients for our nonlinear regression equation, matching those obtained 

using the option in the Format Trendline window. 

 
Example #3 

 
The non-linear regression in Excel works when the number of dependent variables is one. However, the 

source data can have more than one independent variable. 

 
For example, in the table below, Z is the dependent variable. And 1/X and Y are the independent variables. 

https://www.excelmojo.com/array-formulas-in-excel/
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Using the column A values, we must determine 1/X values in column D. And determine the non-linear 
regression in Excel for the given variables Z, 1/X, and Y. 

Then, the steps are as follows: 

Step 1: To begin with, select cell D2, enter the formula, and then, press Enter. 

 
=1/A2 

 

And using the fill handle in excel, enter the formula in cell range D3:D8. 

https://www.excelmojo.com/excel-fill-handle/
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Next, we will use the Regression analysis tool from the Data Analysis ToolPak feature in the Data tab to 
obtain the nonlinear regression equation required for the analysis. 

 
Suppose the Data tab does not show the Data Analysis option, as depicted below: 

 

Then, here are the steps to enable the option in the Data tab. 
 

Step 2: Next, click File – Options to open the Excel Options tab. 

https://www.excelmojo.com/analysis-toolpak-in-excel/
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Then, choose Add-ins in the menu and then, click Go in the Excel Options window. 
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Now, the Add-ins window will open, where we must check the Analysis ToolPak box and click OK. 

 

We can now see the Data Analysis option from the Data tab. 
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Step 3: Next, click on a cell in the table range C1:E8 and then, follow the path Data – Data Analysis to 
open the Data Analysis window. 

 

Next, pick Regression from the Analysis Tools list in the Data Analysis window, and click OK. 
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Step 4: The Regression window   opens.   Update   the Z variable   dataset   as   the   input Y range   and 
the 1/X and Y variables’ data ranges as the input X range. 

 
Include the column headings in the input ranges and check the Labels box to view the variable names in the 

output. Also, we shall assume the constant is 0 and let the confidence level be 95%, implying the 

significance threshold is 0.05. 
 

And let us pick the first option under Output options and set the range as cell G2 to view the summary in 

cell G2 of the current worksheet. 
 

Finally, click OK to obtain the below summary output. 
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The R Square value is 0.996938507. It indicates that the model fits the data well. 

 
Also, the P-value of the two independent variables, 1/X and Y, is below 0.05, the significance threshold, 

indicating the model is significant. 
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Thus, we can use the coefficients of the two independent variables, 1/X and Y, to form the required 

nonlinear regression equation in cell H1. 
 

Important Things To Note 
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 The trendline will not be linear when calculating the non-linear regression in Excel. Thus, ensure to 

pick the trendline curve from the Format Trendline window that best fits the model to the data. 

 The R-squared value does not count in nonlinear regression. But we can use it to pick the suitable 

trendline curve from the options in the Format Trendline window, with a higher value indicating the 

model fits the data better. 

 When using the Regression Analysis ToolPak to calculate nonlinear regression, ensure the 

independent variables’ P-value is below the significance threshold. It indicates the model is 

significant, and we can use the independent variables’ coefficients to create the nonlinear regression 

equation. 

 

Frequently Asked Questions 

 
1. Can Excel do non-linear regression? 

Excel can do non-linear regression. It calculates the nonlinear least square regression to determine the 

nonlinear relationship between response and predictors. 

 
2. What is linear vs non-linear in Excel? 

Linear vs. non-linear in Excel is one of the two ways of performing regression analysis. 
 

Linear regression creates a straight line that graphically represents the linear relation between the dependent 

and independent parameters. 

 

On the other hand, non-linear regression creates a curve, graphically representing the nonlinear relationship 

between the dependent and independent variables. 

 
3. How do you find the non linear line of best fit in Excel? 

We can find the non linear line of best fit in Excel using the Trendline Options in the Format 

Trendline window. Let us see the steps with an example. 

 

The following table contains the average annual rainfall data from 2011-20. 
 

 

Here is how to find the non-linear line of best fit in Excel for the above data. 
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Step 1: First, click on a cell in the table and then, follow the path Insert – Scatter (X, Y) or Bubble 

Chart – Scatter chart. 
 

 

Step 2: Next, click Chart Elements – Trendline right arrow – More Options to open the Format 

Trendline window. 
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The       linear        trendline        will        appear        by        default        as        the        best -fit        line. 

Next, scroll down the Format Trendline window to select the options to display the line equation and R- 

squared value. 
 

We now must check the trendline curve that best fits the model to the data. And for that, we can select one 

Trendline curve at a time and check the R-squared value. The one with the highest R-squared value will be 

the best-fitting curve. 

 

Step 3: Next, pick each curve one by one under Trendline Options and then, check the respective R- 

squared value. 
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For all the above-chosen options, the R-squared values are low. 

 

Hence, we shall now check the Polynomial curve and change the Order one step at a time using the drop- 

down buttons to look for the curve with the highest R-squared value. 
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The Order of 6 is the maximum value that Excel offers. And in this example, the Polynomial curve 

with Order 6 shows the highest R-squared value, 0.9687 or 96.87%. 

 

Thus, the non-linear line of best fit for the given data is the Polynomial curve of order 6. 

Step 4: Then, click Chart Elements – Axis Titles. 

Next, double-click the chart and axis titles elements one at a time to update them as depicted below: 

 

 
Step 5: Finally, resizing the chart to view the nonlinear regression equation properly will result in the plot 

below showing the nonlinear line of best fit. 
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Download Template 

 
This article must be helpful to understand the Non-linear Regression In Excel, with its formula and 

examples. You can download the template here to use it instantly. 
 

Non-Linear-Regression-In-ExcelDownload 

Recommended Articles 

 
This has been a guide to Non-linear Regression In Excel. Here we explain how to do Non-linear 

Regression in excel with examples and downloadable excel template. You may learn more from the 

following articles – 

https://www.excelmojo.com/wp-content/uploads/2023/03/Non-Linear-Regression-In-Excel.xlsx
https://www.excelmojo.com/wp-content/uploads/2023/03/Non-Linear-Regression-In-Excel.xlsx


Spread Sheet for Engineers  

139 | P a g e 

 
 

 

 

EXPERIMENT-6 Date: 

 

 

Aim: Matrix Operations Using Excel: Adding Two Matrices, multiplying a Matrix by a Scalar, 

Multiplying Two Matrices, transposing a Matrix, inverting a Matrix and Solving System of Linear 

Equations. 

 

Using MS Excel in Matrix Addition 

Example 1: I 

 

Find A + B and name the resulting matrix as 

Solution: a) Enter the matrices A and B anywhere into the Excel 

sheet as: 
 

Notice that Matrix A is in cells B2:D4, and Matrix B in cells G2:I4 b) The 2 matrices are 3 by 3, so the 

resulting matrix will also have 3 rows by 3 columns. Highlight the cells where you want to place the 

resulting matrix C: 

 

 

c) Once you have highlighted the resulting matrix, and while it is still highlighted, enter the following 

formula: =B2:D4 + G2:I4 

d) When the formula is entered, press the Ctrl key and the Shift key simultaneously, then press the Enter key. 

This will change the formula you just wrote to: {=B2:D4 + G2:I4} 

If you don't press these keys simultaneously (holding down Shift and Ctrl then press Return), the result will 

appear only in one cell or, you will get some error message). 

e) The resulting matrix will be: 

 

Example 2: Repeat the previous example, but this time find 3A - 2B and name the resulting matrix as D 

Solution: The original formula will be changed to =3*(B2:D4) -2*(G2:I4), the other steps stay the same 
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Using Microsoft Excel 2007 to Perform Matrix Operations 

 

PURPOSE: This handout was created to provide you with step-by-step instructions on how to perform 

various matrix operations when using Microsoft Excel 2007. 

 

How to organize (enter) data in matrices: 

A computer spreadsheet is a series of small blocks (cells) where the 

columns are labeled with capital letters and the rows are labeled by 

numbers. To enter a matrix into Microsoft Excel, simply type each 

matrix element into its own small block (cell). 

Pressing ENTER after each entry will usually make the cursor go down 

to the next cell. (See the note below.) Pressing the RIGHT ARROW 
 

 

NOTE: The default direction is down, but you can change the direction in which the cursor moves in 

through the EXCEL OPTIONS dialog box: 

MICROSOFT OFFICE BUTTON→ EXCEL OPTIONS → ADVANCED → UNDER 

EDITING OPTIONS 
 

How to add matrices: 

Many of the Microsoft Excel functions that you will be using to complete these matrix operations are array 
functions – returning more than one value at a time. To enter an array function into a Microsoft Excel 
worksheet, you must hold down the CTRL and SHIFT keys while pressing the ENTER key: 

CTRL+SHIFT+ENTER.    Once this is done, braces will surround the array formula. 
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1. Enter the data of each matrix. 

 
2. Highlight another section of the worksheet 

(near the given matrices) that has the 
same dimensions as the answer matrix. 

Let's say that we wish to find: [A] + [B] 
Since we are adding two 3 x 3 matrices, 
the sum matrix will also be 3 x 3. 

 

3. Type: = (A2:C4)+(E2:G4) (This will appear in the formula bar.) 

4. Since this answer will result in an array (matrix), you will need to: 

CTRL+SHIFT+ENTER (NOTE: Braces will surround the formula.) 

 
How to subtract matrices: 

 

1. Enter the data of each matrix. 
 

2. Highlight another section of the 

worksheet (near the given matrices) that 

has the same dimensions as the answer 

matrix. 
 

Let's say that we wish to find: [A] – [B] 

Since we are subtracting two 3 x 3 matrices, the difference matrix will also be 3 x 3. 

3. Type: = (A2:C4)–(E2:G4) (This will appear in the formula bar.) 

 
4. Since this answer will result in an array (matrix), 

you will need to: CTRL+SHIFT+ENTER How 

to find the transpose of a matrix: 

1. Enter the elements of the given matrix. 

2. Highlight another section of the worksheet (near 

the given matrix) that has the same dimensions as 

the answer matrix. 

Since we are finding the transpose of a 2 x 3 

matrix, the answer will be a 3 x 2 matrix. 

3. Type: = TRANSPOSE (A2:C3) (This will appear in the formula bar.) 

4. Since this answer will result in an array (matrix), you will need to: CTRL+SHIFT+ENTER How to 

multiply a matrix by a scalar (real number): 

1. Enter the elements of the given matrix. 

2. Highlight another section of the worksheet (near the given 

matrix) that has the same dimensions as the answer 

matrix. 
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Excel 2007 & Matrix Operations page 3 of 4 

Let's say that we wish to multiply the given matrix of a scalar of three (3). Since we are multiplying a 

4 x 3 matrix by the scalar, our result will also be a 4 x 3 matrix. 

3. Type: = 3*(A3:C6) (This will appear in the formula bar.) 

4. Since this answer will result in an array matrix), you will need to: TRL+SHIFT+ENTER How to 

multiply two matrices: 

1. Enter the data of each matrix to be 

multiplied. 

2. Highlight another section of the 

worksheet (near the given matrices) that 

has the same dimensions as the answer 

matrix. 

Let's say that we wish to find the 

product of matrix A (3 x 3) and matrix B (4 x 3). 

Recall that the number of columns of the first 

matrix must be equal to the number of rows of 

the second matrix to produce a product matrix. 

Therefore, we must find the product of [B] x [A] 

– which will be a 4 x 3 matrix. 
 

3. Type: = MMULT (E2:G5, A2:C4) (This will 

appear in the formula bar.) 

4. Since this answer will result in an array (matrix), you will need to: CTRL+SHIFT+ENTER. 

How to find the inverse of a square matrix: 

1. Enter the square matrix that is to be inverted. 
 

2. Highlight another section of the worksheet (near the given matrix) that has the same dimensions as the 

given square matrix. 
 

Since we were given a 3 x 3 matrix, its inverse will also be a 3 x 3 matrix. 
 

3. Type: = MINVERSE (A2:C4) (This will 

appear in the formula bar.) 
 

4. Since this answer will result in an array (matrix), 

you will need to: CTRL+SHIFT+ENTER How to find 

the determinant of a square matrix: 

1. Enter the given square matrix. 

2. Highlight a cell of the worksheet (near the given 

matrix) where you wish the answer to appear. 

In the diagram at the right, the answer will appear 

in cell G2. 



Spread Sheet for Engineers  
 
 

143 | P a g e 

 

 

 

3. Type: = MDETERM (A2:C4) (This will appear in the formula bar.) 
 

4. Since this answer will NOT result in an array (matrix) of more than one answer, you may just press 

ENTER to get the result. (However, if you forget – and do CTRL+SHIFT+ENTER, you will get 

the same result.) 

How to use inverse matrices to solve systems of linear equations: 
 

 

 
 

 

 

1. Enter the data for the coefficient matrix and the 

constant matrix (as shown). 
 

 
 

 

 

 

 
3. Multiply the "inverse matrix" by the constant 

matrix: 

 Highlight: cells G9 to G13 

 Type: = MMULT(A9:E13,G2:G6) 

 Remember to CTRL+SHIFT+ENTER. 

The answers to the given system will appear in the 

resulting matrix. In the given example, the 

solutions are: v = 1, w = 2, x = 3, y = 4, z = 5 

2. Find the inverse of the coefficient 

matrix: 

 Highlight: cells A9 to E13 

 Type: =MINVERSE (A2:E6) 
 

 

 

 

Recall: A matrix will have no inverse if its determinant is zero. So, before attempting to find the 

inverse of a coefficient matrix, you may want to check the value of its determinant. If the 

coefficient matrix of a system of linear equations has a determinant equal to zero, the system 

will not have a unique solution. And, you will have to find the general solution by hand – using 

the Gauss-Jordan Elimination Method. 
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System of Linear Equations 

This example shows you how to solve a system of linear equations in Excel. For example, we have 

the following system of linear equations: 

5x +1y+8z = 46 

4x - 2y = 12 

6x +7y+4z = 50 

In matrix notation, this can be written as AX = B 

If A -1 (the inverse of A) exists, we can multiply both sides by A-1 to obtain X = A-1B. To solve this 

system of linear equations in Excel, execute the following steps. 

1. Use the MINVERSE function to return the inverse matrix of A. First, select the range B6:D8. 

Next, insert the MINVERSE function shown below. Finish by pressing CTRL + SHIFT + ENTER. 

 

Note: the formula bar indicates that the cells contain an array formula. Therefore, you cannot 

delete a single result. To delete the results, select the range B6:D8 and press Delete. 

2. Use the MMULT function to return the product of matrix A-1 and B. First, select the range 

G6:G8. Next, insert the MMULT function shown below. Finish by pressing CTRL + SHIFT + 

ENTER. 

 
3. Put it all together. First, select the range G6:G8. Next, insert the formula shown below. Finish by 

pressing CTRL + SHIFT + ENTER. 
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4. If you have Excel 365 or Excel 2021, simply select cell G6, enter the same formula as above and 

press Enter. Bye bye curly braces. 

Note: this dynamic array formula, entered into cell G6, fills multiple cells. Wow! This behavior in 

Excel 365/2021 is called spilling. 



Spread Sheet for Engineers  
 
 

146 | P a g e 

 

 

 

 

 

EXPERIMENT-7 Date: 

 

 

Aim: VBA User-Defined Functions (UDF): The Visual Basic Editor (VBE), The IF Structure, 

The Select Case Structure, The for Next Structure, The Do Loop Structure, Declaring Variables and 

Data Types, An Array Function the Excel Object Model, For Each Next Structure. 

 

 

Syntax of the Select Case Statement of Excel 

VBA 

 

The Select Case statement in VBA is similar to the Switch Case statement used in programming languages 

like Java, C#, PHP, etc. The syntax of the Select Case statement of Excel VBA is given as follows: 

 

 
S e l e c t [ C a s e ] E x p r e s s i o n f o r t e s t i n g 

 

[ Case] List of Expression Statements  ( Case 1 , Case 2 , Case  3 and so 

on...) 

Case Else (Else Statements)  

End 

Select 
End Sub 

 

 

 

 
The Select Case statement of Excel VBA accepts the following arguments: 

 

 Expression for testing: This is a single expression that is to be compared with the different 

Cases. It can either be a numeric or textual expression. So, it can evaluate to a character, integer, 

Boolean, object, string, etc.

 List of expressions: This is the list of expressions (called Case statements) against which the 

"expression for testing" is compared. Excel VBA looks for an exact match within these Case statements. 

These Case statements consist of one or more possible outcomes (values or conditions) that may or 

may not match the "expression for testing." If there are multiple expressions (or values) within 

a single Case, they must be separated by commas. The following keywords can be used in Case 

statements:
o The To keyword should be used when a range of values needs to be specified in a Case 

statement. The value preceding the To keyword should be less than or equal to the value 

succeeding this keyword. 
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o The Is keyword should be used when a logical operator (=, <>, <, >, < = or > =) needs to be entered 

in a Case statement. This keyword should be inserted before the logical operator. 

 
 Statements: This is one or more codes succeeding the "list of expressions." Only that code is executed 

for which the "expression for testing" matches the "list of expressions."

 Case Else statement: This consists of one or more codes (or statements), which are executed when 
all the Case statements (or list of expressions) are false.

 End Select: It closes the Select Case structure. Every Select Case statement must necessarily have an 

End Select statement.
 

The "expression for testing," "list of expressions," and End Select clauses are required in a Select Case 

construction. However, the "statements" and Case Else statements are optional in the given syntax. 

 
Note 1: In a Select Case statement in VBA, each Case statement is compared with the "expression for 

testing." Once a condition is met (or the Case statement is matched), no further Case statements are 

tested. However, if a condition is false (or the Case statement does not match), the next Case statement 

is tested. 

 
The testing of Case statements (or conditions) continues till one of the specified conditions is met or till the 

Case Else or the End Select statement. If none of the tested conditions is true and there is no Case Else 

statement, control passes to the End Select statement. 

 
Note 2: If the "expression for testing" matches more than one Case statement, only the code of the first 

such match is executed. 
 

How to use the Select Case Statement of 

Excel VBA? 

The Select Case statement is a feature of Excel VBA. One can access VBA from the "visual basic" option of the 

Developer tab of Excel. In this tab, the user-defined functions (UDF) and their codes can be created. 
 

The Select Case statement of VBA should be used in place of the 

nested II- statement of Excel. This is because the former is easier to understand and execute than the 

latter. 

 
The steps to use the Select Case statement of VBA are listed as follows: 

 

a. Create a command button and place it in the Excel worksheet. When the command button is 

clicked, a macro runs. The running of the macro performs an action. 

b. Right-click the command button and choose the option "view code." The Visual Basic Editor 

opens. 

c. Enter the code between the CommandButton function and End Sub. 
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d. Debug and compile the code to identify the syntax errors. 

e. Change the input values to observe the different outputs. 

Note 1: The user-defined functions (UDF) are customized functions that cater to the specific needs of the 

user. 

 
Note 2: Every time the input is changed (in point e), the "expression for testing" changes. As a result, the 

conditions that match this expression change. Hence, different codes are executed each time the input 

values change. 
 

VBA Select Case Examples 

 

 
You can download this VBA Select Case Excel Template here — VBA Select Case 

Excel Template 
 

 

E xa mpl e # 1 " Exp re s s i on f o r T es t i ng" i s En t e r ed Directly 

 
In the following code, the "expression for testing" is A=20 and the Case statements are 10, 20, 30, and 40. 

There is also a Case Else statement in this code. 

 

 
PrivateSubSelcaseexmample()Dim A As Integer 

A = 20 

 
Select Case A 

 
 

Case 10 

MsgBox"FirstCaseismatched!" 

 

Case 20 

MsgBox"TheSecondCaseismatched!" 

 

Case 30 

MsgBox"ThirdCaseismatchedinSelectCase!" 

 
Case 40 

MsgBox"FourthCaseismatchedinSelectCase!" 

 

 
 

On running the preceding code, the following output is obtained. 
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Case Else 

MsgBox"NoneoftheCasesmatch!" 

 

End Select 

End Sub 
 
 

 

Explanation: The expression A=20 is compared with the four Case statements 10, 20, 30, and 40. A match 

is found in the second Case statement (Case 20). Consequently, the message of the second Case 

statement is displayed, which is "the second Case is matched." 

 
Had the expression not matched with any of the Case statements, the message of the Case Else statement 

would have been displayed. 

 

Note: The MsgBox function of VBA displays a dialog box containing a customized message. 
 

Example #2-"Expression for Testing" is Compared 

with a Range of Values Using the "To" Keyword 
 

In the following code, the "expression for testing" is collected from the user with the help of the 

InputBox function of VBA. There are four Case statements, namely Case 1 To 36, Case 37 To 55, Case 56 

To 80, and Case 81 To 100. There is also a Case Else statement in the code. 

 

 
Private Sub Selcasetoexample 

Dim studentmarks As Integer 

studentmarks = Input Box(" Enter marks between 1 to 100.") 

Select Case studentmarks 

Case 1 To 36 
Msg Box 

" Fail!" 

 

Case 37 To 55 

MsgBox "C 

Grade" 
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Case 56 To 80 

MsgBox "B 

Grade" 

 
Case 81 To 100 

MsgBox "A 

Grade" 

 

Case Else 

MsgBox "Out of range" 

 

End 

Select 

End Sub 

 

 

 
 

On running the preceding code, the user is asked for input. Assume that the user enters 90. So, the following 

output is obtained. 

 

 
Explanation: The Case statements of the preceding code contain a range of values. Notice that in the 

code, each number preceding the To keyword is smaller than the number succeeding this keyword. 

 
The "expression for testing" is entered as 90 by the user. This expression matches the fourth Case statement 

(Case 81 to 100). So, the code in this Case statement is executed. Hence, the message "A grade" is returned 

by VBA. This output is displayed in a dialog box due to the usage of the Msg Box function in the code. 

Both numbers (preceding and succeeding the To keyword) of the range are inclusive. So, had the user 

entered 81, it would have again matched with the fourth Case statement. However, had a number 

greater than 100 been entered, the output would have been "out of range." This message is defined in the 

Case Else statement of the code. 

 

Note: The InputBox function collects the input from the user through a dialog box. The message shown 

in this dialog box is the same as that entered in the InputBox function of the code. 

 

Example #3-"Expression for Testing" is Compared 

with Numbers Using the "Is" Keyword 
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In the following code, the "expression for testing" is collected from the user. There are two Case 

statements, namely Case Is < 200 and Case Is > = 200. There is no Case Else statement in the code. 

 

 
Sub CheckNumber() 

Dim NumInput As Integer 

NumInput = InputBox("Please enter a number.") 

Select Case NumInput 

Case Is < 200 

MsgBox "You entered a number less than 200" 

 

Case Is >= 200 

MsgBox " You entered a number greater than or equal to 200" 

 
End 

Select 

End Sub 

 

On running the preceding code, a dialog box containing the message "please enter a number" is 

displayed. Assume that the user enters 200. So, the following output is displayed. 

 
 

Explanation: Observe that the two logical operators (< and >=) in the code are preceded by the "Is" 

keyword. Had this keyword not been supplied, VBA would have automatically inserted it before the 

logical operators. 

 

The "expression for testing" is entered by the user as 200. This expression is compared with the two Case 

statements of the preceding code. A match is found in the second Case statement. This is because 200 is 

not greater than but is equal to 200. 

 
Notice that there is no Case Else statement in the preceding code. This is because whatever number the user 

enters, it falls within either of the two Case statements. So, one of the two Case statements will always be 

true. Hence, the Case Else statement is not required as it runs only when all Case statements evaluate 

to false. 

 

Example #4-"Expression for Testing" is Entered in a 
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Cell and Evaluated by the Command Button 

 
In the following code, the "expression for testing" is taken from cell Al of the Excel worksheet. There 

are three Case statements and one Case Else statement. 

 

 
 

Sub color() 

Dim color As String 

color = Range("Al").Value 

Select Case color 

Case "Red","Green","Yelow"Range("Bl").Value 

= 1 

 

Case "White", "Black", "Brown" Range("Bl").Value 

= 2 

 

Case "Blue", "Sky Blue" 

Range("Bl").Value = 3 

 
C a s e E l s e 

Range("Bl").Value=4 

 

End Select 

End Sub 

 

 

 
 

Further, a command button has been created in the worksheet with the help of ActiveX controls. The 

input entered in cell Al, the command button, and the output obtained in cell B1 are shown in the 

following image. 
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Explanation: The preceding code is executed by clicking the command button of the Excel worksheet. 

Notice that multiple expressions of each Case statement are separated by commas (like "Red", "Green", 

"Yellow"). 

 

The "expression for testing" is entered as "pink" in cell Al. This expression matches none of the three 

Case statements specified in the code. Consequently, the code of the Case Else statement is executed. 

So, the output in cell B1 is 4. 
 

Had the user entered a color (in cell Al) specified in any of the three Case statements, the 

corresponding code would have run. For instance, had the user entered "White" in cell Al (without the 

double quotes and with "W" capital), the output in cell B1 would have been 2. 

 

Hence, a change in the input of cell Al causes the output of cell B1 to change. 
 

Example #5-"Expression for Testing" is Divided by 2 

with the MOD Operator of VBA 

 
In the following code, the "expression for testing" is collected from the user. There are two Case 

statements, namely Case True and Case False. The Case Else statement is not there in the code. 

 

 
SubCheckOddEven() 

CheckValue=InputBox("Enteranumber.") 

SelectCase(CheckValueMod2) = 0 

Case True 

MsgBox"Thenumberis even" 

 
Case False 

MsgBox"Thenumberis odd" 

EndSelect 
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End Sub 

 

 
 

VBA If Else statements 

 

Building a VBA If Else[1] statement is quite similar to building a nested if formula inside Excel. The 

benefit of using VBA instead is that it’s much easier to follow, since nested IFs tend to complicate with 

multiple parenthesis enclosures. In a VBA if statement, each IF clause is separate from the other, and is 

instead laid out in order of priority from top to bottom. 

 
If Statement Structure in VBA 

 

If Range(“A5”) = “YES” Then 

Range(“A5”).Value = “NO” 

End If 

 

 If statements begin with an If [CRITERIA] Then statement

 If the user does not wish to add additional statements, the if statement is closed by an End If

 In the above example, no false statement is present. Thus, if Cell A5 is not YES, VBA will simply 

skip this statement and move on to whatever code follows it. If Cell A5 is YES, the process 

contained in the If statement will be run.

 

If Range(“A5”) <= 100 Then 

Range(“A6”).Value = “Decent Performance” 

Else If Range(“A5”) > 100 Then 

Range(“A6”).Value = “Great Performance” 

End If 

 

 If the user does want to add additional statements assuming the first If … Then is false, then the 

first if…then the process should be immediately followed by the Else If…Then statement.

 There can be multiple Else If…Then clauses in a VBA if statement, as long as each Else If …

criteria is mutually exclusive from other Else If or If criteria. 

 End If should close the last Else If…Then statement.

 In the above example, if Cell A5 is 91, then Cell A6 will be set to Decent Performance.

 

If Range(“A5”) <= 50 Then 

 

Range (“A6”).Value = “Failing Grade” 

Else If Range (“A5”) <= 80 Then 

https://corporatefinanceinstitute.com/resources/excel/vba-if-else/#citation-using-ifthenelse-statements
https://corporatefinanceinstitute.com/if-statement-between-two-numbers
https://corporatefinanceinstitute.com/excel-vba
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Range(“A6”).Value = “Passing Grade” 

Else 

Range(“A6”).Value = “Outstanding Grade” 

End If 

 The user can also elect to include one Else statement, which will activate if all other If and Else If 

statements are false.

 Else statements are not followed by Then, unlike If…Then and Else If…Then statements.

 End If should close an Else statement and only the Else statement, if it is used.

 In the above example, if Cell A5 is 91, then Cell A6 will be set to Outstanding Grade.

 Else statements act as a “catch-all” and will ensure that one process is run even if all the other If 

statements are false.

 Excluding an Else statement may result in the entire if to end if statement being skipped over if all 

criteria are false.

 

An If formula in Excel worksheets needs a clause to perform if the statement is true and one to perform if 

the statement is false. In contrast, a VBA if statement only needs code to perform if the statement is true. 

The section defining what to perform if that statement is false is optional. If the VBA statement turns out 

to be false and no process is defined for a false statement, then VBA will simply skip the if statement and 

move on to the next 
 

 

 

 

 

 

 

https://corporatefinanceinstitute.com/sheet-name-code-excel
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EXPERIMENT-8 Date: 

 

Aim: VBA Subroutines or Macros: Recording a Macro, coding a Macro Finding Roots by Bisection, 

Using Arrays, adding a Control and Creating User Forms. 

 

Excel Macro is simply a record button that records a set of actions performed on Excel that can be run 

multiple times. For example, if you have to format some raw data on weekly basis you can use a macro 

to record yourself formatting the data once and let excel automate the task in the future. it’s used to help 

users save time and avoid performing redundant tasks. 

In order to record a macro the Developer tab on the ribbon needs to be activated as it isn’t on by default 

within Microsoft Excel. The developer tab contains all the macro tools among various other features. 

To activate it click on the file tab> goto options>Customize Ribbon Under Customize   the 

Ribbon and under Main Tabs, select the Developer check box. (The developer tab stays on the ribbon 

unless checked off ). 
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To record a macro follow these steps : 

Step 1: click on the view tab, select Macros(extreme right), and hit Record Macro. 

 

 

 

 

 

 

 

 
Step 2: A Record Macro dialog box pops up. 

 
 

The record macro dialog box has 4 sections to be filled 

 Macro name: give a name to your macro (avoid spaces and keep it short) 

 Shortcut Key: you can select any letter to create a shortcut key, be careful not to override an 

existing shortcut   key.   (you   can   press shift and   any   letter   in   the   box   to   create 

a ctrl+shift+letter key) 

 Store macro in: select This workbook to run it only in the current workbook, personal 

macro workbook so the macro can be used within any workbook on the computer that 

contains that personal macro workbook and new workbook to run it in a new workbook it 

creates at the time of recording. 
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 Description: Here you can provide additional information about the macro(what it does) for 

the users or ourselves. 

Step 3: Click ok and Excel will start recording all of your actions henceforth. 

 
Step 4: Once done, remember to hit the stop recording button in the lower-left corner of the worksheet 

or head over to view>Macros>stop recording. 

 
 

Stop recording button bottom left corner. 



Spread Sheet for Engineers  
 
 

160 | P a g e 

 

 

 
 

 
 

The above steps should help you get started recording a macro. 

The Visual Basic Editor 

Excel has a tool called the Visual Basic Editor or VBA that makes note of all the actions you perform 

while recording a macro in the backend. When you record a macro inside excel through the macro 

recorder all the code gets stored in a module. To see the code that excel has written head to the 

Developer tab>code section>Visual Basic this opens up a separate window called the Visual Basic 

Application window along the left side of this window you will find the module under the project 

Explorer(if you don’t see it click on View>Project Explorer) double click it and all the text is the code 

that excel generated while recording the macro. 

 

 
 

Absolute and Relative recording: 

A macro can be recorded in 2 ways namely Absolute and Relative recording. When you record a macro 

in Excel it is by default in the Absolute recording mode. In the absolute recording, the steps are 

performed exactly in the cells the steps were recorded in despite the active cell. In simple words, 

absolute recording restricts the location of steps. Relative recording executes the steps recorded in any 

part of the worksheet selected by the user as its relative to the starting location of the macros. To turn on 

Relative recording head to Developer tab>Code>Use Relative References(gets highlighted in grey 

when selected) and then start recording the macro. 

 

 
Limitations of an Excel Macro: 
Macros have certain limitations pertaining to them and can be combated by writing the VBA code 

manually. Some of them are as follows 

 A macro doesn’t record what options you select within a dialog box. 

 If you need to make any decisions in your process (code), the macro recorder can’t help you 

make them. you can use the IF statement or other conditional statements. 

 The macro recorder can’t throw message boxes to prompt the user. 

Macro-Enabled File Extensions: 

There are some file extensions that do not store a macro hence you need to be careful about using a 

macro-enabled format to save your workbook or the macro won’t be saved. 
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The default Excel format of the Excel workbook is .xlsx which does not support macros. To store 

macros you save and open workbooks in a new macro-enabled workbook format .xlsm. this format is 

the same as .xlsx, but with the capability to support Excel macros. 

The Excel Binary Workbook(.xlsb) and Excel macro-enabled template(.xltm) are some more file 

extensions that support macros within them. 

Steps to save a macro-enabled workbook : 

 Click on the File tab and then choose Save As. The Save As dialog box appears. 
 Enter a name for the and select a location for your workbook. 

 Click the Save as Type drop-down arrow. A list of file types appears. 

 Select Excel Macro-Enabled Workbook. Click on Save. 

 

 
Some more real-time applications of macros can be used to record the creation of charts based on some 

data, filtering and sorting data, formatting data, or importing it 
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